SOFTWARE MANUAL

VisiLogic - Getting Started

V230-21-G23 Rev: 3:00
The information in this document reflects products at the date of printing. Unitronics reserves the right, subject to all applicable laws, at any time, at its sole discretion, and without notice, to discontinue or change the features, designs, materials and other specifications of its products, and to either permanently or temporarily withdraw any of the foregoing from the market.

All information in this document is provided "as is" without warranty of any kind, either expressed or implied, including but not limited to any implied warranties of merchantability, fitness for a particular purpose, or non-infringement. Unitronics assumes no responsibility for errors or omissions in the information presented in this document. In no event shall Unitronics be liable for any special, incidental, indirect or consequential damages of any kind, or any damages whatsoever arising out of or in connection with the use or performance of this information.

The tradenames, trademarks, logos and service marks presented in this document, including their design, are the property of Unitronics (1989) (R°G) Ltd. or other third parties and you are not permitted to use them without the prior written consent of Unitronics or such third party as may own them.
Table of Contents

VisiLogic Overview ........................................................................................................... 5

Minimizing EMI: System Design Guidelines ................................................................. 8

- Devices Emitting high EMF ...................................................................................... 8
- Wiring Separation ..................................................................................................... 8
- Enclosing and Earthing ......................................................................................... 8
- I/O Wiring: General Guidelines ............................................................................ 9
- Signal (Communication, I/O) Line Filtering ......................................................... 9
- Wiring Power for I/O Expansion Modules ............................................................. 10
- Power-line Filtering .............................................................................................. 11
- Connect the EX-A1 Communication Cable .......................................................... 12

Getting Started ........................................................................................................ 14

- Hardware Configuration ...................................................................................... 14
- Ladder Editor ....................................................................................................... 14
- HMI Display Editor .............................................................................................. 16
- About the HMI Display and Keypad ................................................................. 17
- Variables ............................................................................................................. 18
- Quick Navigation ................................................................................................ 21
- Downloading/Uploading a Project ....................................................................... 22
- On-Line Test Mode (Debug) ................................................................................ 26
- Information Mode ............................................................................................... 28
- COM Ports and Data Communications ............................................................... 32
- About Modems .................................................................................................... 33

Hardware Configuration ......................................................................................... 37

- I/O Expansion Modules ..................................................................................... 37
- Snap-in I/O Expansion Modules .......................................................................... 42
- Configuring a High-Speed Counter .................................................................... 46
- Configuring a High-speed Output (PWM) .......................................................... 46
- Configuring an Analog Input ............................................................................ 49
- Analog Filters, PLC ............................................................................................ 49
- Configuring an Analog Output ......................................................................... 51
- Analog I/O Ranges ............................................................................................. 51
- Working with Analog I/O Values ................................................................. 53
- Configuring Digital Inputs .............................................................................. 55
- Configuring Digital Outputs ............................................................................ 56
- Assign a Description to Multiple Operands ..................................................... 57

Controller Settings .............................................................................................. 58

- Vision Communication PC Settings ............................................................... 58
- Communication and OS-Controller Menu ......................................................... 59
- Run, Reset, Initialize ......................................................................................... 59
- Get COM Parameters and PLC status ............................................................. 60
- Downloading an OS .......................................................................................... 60
- Check CANbus Network Status ......................................................................... 62

Remote Access ....................................................................................................... 64

- Remote Access: Accessing a PLC via PC ....................................................... 64
<table>
<thead>
<tr>
<th>Utilities</th>
<th>70</th>
</tr>
</thead>
<tbody>
<tr>
<td>Utilities: an Overview</td>
<td>70</td>
</tr>
<tr>
<td>Tools</td>
<td>76</td>
</tr>
<tr>
<td>Creating Project files (.dvi, .vdf, .urc, .ura)</td>
<td>76</td>
</tr>
<tr>
<td>Project Properties</td>
<td>78</td>
</tr>
<tr>
<td>Digital Signatures</td>
<td>82</td>
</tr>
<tr>
<td>Operand View</td>
<td>83</td>
</tr>
<tr>
<td>Hotkeys: Quick Editing</td>
<td>84</td>
</tr>
<tr>
<td>Watch Folders</td>
<td>85</td>
</tr>
<tr>
<td>Memory Tab</td>
<td>86</td>
</tr>
<tr>
<td>Find (&amp; Replace)</td>
<td>87</td>
</tr>
<tr>
<td>Search: Symbolic Name</td>
<td>92</td>
</tr>
<tr>
<td>Deleted Unreferenced Operands</td>
<td>93</td>
</tr>
<tr>
<td>Print Project</td>
<td>93</td>
</tr>
<tr>
<td>System Images</td>
<td>94</td>
</tr>
<tr>
<td>Converting Projects</td>
<td>95</td>
</tr>
<tr>
<td>Import/Export Subroutines</td>
<td>95</td>
</tr>
<tr>
<td>Verify Project</td>
<td>98</td>
</tr>
<tr>
<td>Compile</td>
<td>99</td>
</tr>
<tr>
<td>Project Optimizer</td>
<td>99</td>
</tr>
<tr>
<td>Log</td>
<td>100</td>
</tr>
<tr>
<td>Show STL</td>
<td>100</td>
</tr>
<tr>
<td>Power-up Modes: Trouble-shooting</td>
<td>100</td>
</tr>
<tr>
<td>Memory Allocation</td>
<td>102</td>
</tr>
<tr>
<td>Appendix A: Troubleshooting</td>
<td>104</td>
</tr>
<tr>
<td>Detecting Short-circuited End Devices</td>
<td>104</td>
</tr>
<tr>
<td>Positive Transition Contact ( Rise )</td>
<td>104</td>
</tr>
<tr>
<td>I/O Expansion Module Errors</td>
<td>108</td>
</tr>
<tr>
<td>Analog Input Values: Out of Range</td>
<td>108</td>
</tr>
<tr>
<td>Compile</td>
<td>109</td>
</tr>
<tr>
<td>Compatibility: HW, OS, SW</td>
<td>110</td>
</tr>
<tr>
<td>Updating Project Versions</td>
<td>112</td>
</tr>
<tr>
<td>Why does the Controller display the 'Restart' message?</td>
<td>115</td>
</tr>
<tr>
<td>HMI Element Resizing/Rotating Limitations</td>
<td>115</td>
</tr>
<tr>
<td>Blank Corner in HMI Display</td>
<td>117</td>
</tr>
<tr>
<td>Float Errors</td>
<td>117</td>
</tr>
<tr>
<td>Changing Panel Types: Conflicts</td>
<td>117</td>
</tr>
<tr>
<td>Insufficient Flash Memory</td>
<td>118</td>
</tr>
<tr>
<td>Error: User Memory Overlap</td>
<td>118</td>
</tr>
<tr>
<td>Replacing or Removing the Battery</td>
<td>118</td>
</tr>
<tr>
<td>Appendix B: Vision Controller Divisions</td>
<td>119</td>
</tr>
<tr>
<td>Index</td>
<td>126</td>
</tr>
</tbody>
</table>
If you are new to VisiLogic, please start with this manual. Here, you can learn the basics of the VisiLogic software environment.

These concepts are important even if you have experience programming other controllers. The subjects introduced here are covered in depth in the VisiLogic Software Manual Series.

The Series includes the following manuals in pdf format:

- **VisiLogic: Getting Started**
  This provides a general overview of the VisiLogic environment, Hardware Configuration, Controller Settings, Remote Access, Utilities, and Tools, as well appendices on Troubleshooting and Vision Controller Divisions

- **VisiLogic: Ladder Application Programming**
  Includes a section on Getting Started with Ladder, as well as separate sections on program calls and Ladder functions.

- **VisiLogic: HMI Application Programming**

- **VisiLogic: Communications**

- **VisiLogic: Utilities**
VisiLogic Overview

VisiLogic is the software tool you use to create control projects for Vision controllers.

After you plan the control task, use VisiLogic to write, debug, and download the PLC control and HMI applications into the controller.

The PLC application is your control, or automation application. You write the PLC application using the Ladder Editor.

The HMI application configures the operating panel's function. You use the HMI Editor to create the Displays that are shown on the controller's screen.

Displays tell your operators what to do. You can have your operators log in with a password, enter setpoints and other data, and instruct the operator what to do in case of a system problem or alarm. A Display can contain both text and images. Text and images can be both fixed and/or variable.

Variables are inserted into a Display to:
- Show run-time values as integers
- Represent run-time values with either text, images, or bar graphs
- Show text messages that vary according to runtime conditions
- Enable an operator to enter data using the Vision's alphanumeric keypad

Editors

You use different editors to create your control project:
- Hardware Configuration
- Ladder
- HMI Display
- Variable

Each editor is operated through a different window. You switch between the editors via the Toolbar buttons or by clicking elements in the Project Explorer.

Language Interface

VisiLogic supports a number of interface languages. You can change the interface language by selecting Languages from the VisiLogic View menu.

Hardware Configuration

VisiLogic offers an integral Hardware Configuration module. The foundation of a Vision control system is the controller. The Snap-in I/O Module provides an on-board I/O configuration. You add I/Os by integrating I/O Expansion Modules.

After you select the Snap-in or Expansion I/O modules connected to the controller, you can configure inputs: analog, digital, and high-speed counter/shaft-encoder/frequency measurers and PT100; and outputs: analog, digital, and PWM high-speed outputs.

Ladder Modules and Subroutines

VisiLogic is a modular program that you build using Modules and Subroutines.
Operand View and Watch Folders
VisiLogic allows you to view operands and their contents according to type and whether or not they are in use. You can also group related operands according to functions in Watch Folders.

Vision Controller Divisions
There are two major Vision divisions, Standard and Enhanced. Each division supports different HMI features and Ladder functions.

For more information, refer to Appendix B: Vision Controller Divisions.

VisiLogic Examples
When you install VisiLogic, an Examples folder is created on your hard disk, containing field-tested VisiLogic (.vlp) sample applications. You can copy these sample applications and adapt them for your own use—if, for example, an application is written for the V120, you can select the V230 via Hardware Configuration.

Help Forums
The Unitronics forums are located at http://forum.unitronics.com/.
Note that you can search the forums without subscribing, but that you must subscribe in order to post a question.

Help
Use the VisiLogic Help System to learn how to use the software and answer your questions. The VisiLogic Software Manuals are based on content from the Help system, and are intended for users who prefer to learn from printed documentation.

However, please note that the Help system always contains the most updated content.
Live Update from the Web

Live Update is available from the Help menu. To start Update, select a subject and follow the on-screen instructions.

Note

- After downloading FBs, you must close and then restart VisiLogic. The new FBs will appear on the FBs menu. Check the topic FB Library for more information.

- After downloading a new Operating System to your PC, you must install it in the controller. Connect the controller to your PC, then open Communication and OS from the Connection menu. The new Operating system will appear in the Install Operating System tab. Select Download to begin the installation process.
Minimizing EMI: System Design Guidelines

Before you design your control system, please read the following guidelines:

Unitronics products are designed to operate in a typical industrial environment. These guidelines show you how to design your system for optimal performance in noisy environments.

After installation, check your system periodically, in particular after installing new machinery close to the system.

Devices Emitting high EMF

High voltage, high current, and high frequency circuits such as high voltage / high current power supplies, high power converters and amplifiers, contactors and solenoids, motors and motor-drives may cause severe electro-magnetic disturbances that may affect the operation of other nearby computerized devices such as PLCs or I/O modules.

Such high voltage, high current, and high frequency circuits should not share the same cabinet with PLCs or I/O modules.

If this is unavoidable, within the cabinet, either:

1. Physically separate these sources from PLCs and I/O modules with large metal earthed plates. Such a plate should be large enough to partition the cabinet into two cubicles.
2. Separate these sources and their cabling from PLCs and I/O modules as described in the section Wiring Separation.

Wiring Separation

Use separate wiring ducts for each of the following groups:

1. Digital inputs, digital outputs, 24VDC (power supply for the PLC and I/O Expansion Modules), communications, analog inputs, and analog outputs.
2. Lines that are connected to the power grid, 230/115, 24VAC, all AC lines such as motor driver outputs, noisy DC lines such as DC servo drives and motors.
   Separate these groups by at least 10cm (4"). If this is not possible, cross the ducts at a 90° angle.

Enclosing and Earthing

1. It is recommended to install the PLC and I/O modules in a closed metallic cabinet. This will significantly improve interference immunity.
2. Make sure that the cabinet and cabinet door are properly earthed. Please refer to the cabinet manufacturer instructions for proper installation and earthing.
3. When you earth devices, minimize wire impedance by using a wire that is as short and thick as possible, 3.3mm² (12 AWG), up to 10cm long recommended. Connect the line to nearest possible grounding point in the cabinet, preferably a grounding plate or the cabinet body. Be sure to remove any paint or other non-conductive coating between the wire terminal and metal as this may cause poor conduction.
I/O Wiring: General Guidelines

1. Route each I/O signal / signal-group along with a dedicated common wire (e.g. 0V). This serves as a signal return path and increases interference immunity.
   Connect common wires at the respective common pins of the module where the specified I/O port is located. Please refer to the module installation guide for details.

2. For all types of analog and high-speed I/Os:
   3. Use shielded twisted pair cable
   4. Do not use the shield as a signal or as a return conductor
   5. Ground the shield at the closest grounding point to the I/O port, preferably a grounding plate or the cabinet body.
      This connection method usually gives the best interference immunity. However, in some cases, grounding the shield at both ends of the cable is preferable. In this case, be sure that both points have the same potential in order to eliminate ground currents through the shield.
   6. Route those signals separately from high voltage / high current and AC wiring, as explained in the section Wiring Separation.

Signal (Communication, I/O) Line Filtering

Some environments may induce greater EMI than the typical industrial environment. Extra power and/or signal line filtering may improve the system’s immunity to EMI.

If signal-line filtering is required, please use the following guidelines in addition to the guidelines provided by the filter manufacturer:

1. Place the filter as close as possible to the target device(s); maximum wire length is 10 cm.
2. Signal lines can be filtered using rounded ferrite cores. To maximize their effect, wind the wire through the ferrite core multiple times to attenuate high frequencies as shown below.
3. Always pass both the signal and signal return wires thru the ferrite core.
   If multiple I/O lines share the same common return wire, pass all of these I/O lines and their return wire through the same ferrite core.
Wiring Power for I/O Expansion Modules

The examples below are based on the EX-A1.

1. If the power-supply is closer to the PLC than it is to the module’s power supply (EX-A1):
   - Create 0V and 24V junctions at the PLC respective terminals (see the following figure) and directly connect the PLC main supply lines to the EX-A1.
   - Continue daisy-chaining the supply lines to the expansion I/O units.
   **Please ensure that the wire segment which carries the 0V between the EX-A1 and the PLC does not branch.**

When the power-supply is near the PLC, connect the PLC first as shown in the next figure.

![Diagram](image)

1. If the power-supply is closer to the EX-A1 than it is to the PLC:
   - Create 0V and 24V junctions at the EX-A1 respective terminals (see the following figure) and directly connect the EX-A1 main supply lines to the PLC.
   - Split the supply lines at the EX-A1 terminals and continue daisy-chaining them to the expansion I/O units.
   **Please ensure that the wire segment which carries the 0V between the EX-A1 and the PLC does not branch.**

When the power-supply is near the EX-A1, connect the EX-A1 first as shown in the next figure.
Power-line Filtering

Some environments may induce greater EMI than the typical industrial environment. Extra power and/or signal line filtering may improve the system’s immunity to EMI.

If power-line filtering is required, please use the following guidelines in addition to the guidelines provided by the filter manufacturer:

1. Use of power-line filters that comprise an earthing terminal is recommended. Ground the filter earth terminal as explained in the section Enclosing and Earthing.
2. Place the filter as close as possible to the target device(s). The maximum wire length is 10 cm.
3. When using the EX-A1 expansion adapter:
4. Place one filter for both the PLC and the EX-A1 as instructed below. **Please note** that you must use a single line filter for both the PLC and EX-A1.
5. If the power-supply is closer to the PLC than it is to the EX-A1:
   - Install and connect the power-line filter as close as possible to the PLC. The maximum wire length is 10 cm. Please refer to the filter manufacturer documentation for installation information.
   - Create 0V and 24V junctions at the PLC respective terminals (see the following figure) and directly connect the PLC main supply lines to the EX-A1.
   - Continue daisy-chaining the supply lines to the expansion I/O units.

**Please ensure that the wire segment which carries the 0V between the EX-A1 and the PLC does not branch.**

When the power-supply is near the PLC, connect the PLC first as shown in the next figure.
1. If the power-supply is closer to the EX-A1 than it is to the PLC:
   - Install and connect the power-line filter as close as possible to the EX-A1. The maximum wire length is 10 cm. Please refer to the filter manufacturer documentation for installation information.
   - Create 0V and 24V junctions at the EX-A1 respective terminals (see the following figure) and directly connect the EX-A1 main supply lines to the PLC.
   - Split the supply lines at the EX-A1 terminals and continue daisy-chaining them to the expansion I/O units.

Please ensure that the wire segment which carries the 0V between the EX-A1 and the PLC does not branch.

When the power-supply is near the EX-A1, connect the EX-A1 first as shown in the next figure.

---

Connect the EX-A1 Communication Cable

1. Note that the communication cable is ended by RJ45 plugs. The plug comprising a yellow-green grounding wire must be connected to the PLC as shown in the following figure.

2. This yellow-green wire must be grounded to the metal door panel or cabinet body (which must be also well grounded) using a screw. There cannot be any paint or other non-conductive coating between the wire
terminal and metal as this may cause poor conduction.  
**DO NOT extend the wire.**
Getting Started

Hardware Configuration

Hardware Configuration opens automatically when you first create a new project. In order to open Hardware Configuration in an existing project, either select Hardware Configuration from the View menu or click the button on the toolbar.

Click on the appropriate icon to select the model Vision, the Snap-in I/O module, and any I/O Expansion modules required by your application.

After you select the Snap-in or Expansion I/O modules connected to the controller, you can configure inputs: analog, digital, and high-speed counter/Shaft-Encoder/Frequency measurers and PT100; and outputs: analog, digital, and PWM high-speed outputs.

**Note**

You must select the correct Vision model and Snap-in I/O modules before downloading your project.

To avoid exceeding the I/O capacity of your controller, check the I/O report at the bottom of the Hardware Configuration window.

Ladder Editor

Use the VisiLogic Ladder Editor to create the Ladder diagram that comprises your control application. Ladder diagrams are composed of contacts, coils, and function block elements arranged in nets.
In a Ladder diagram, the contacts represent input conditions. They lead power from the left Ladder rail to the right rail. This is why the first element in a net must always touch the left rail. Coils represent output instructions. In order for output coils to be activated, the logical state of the contacts must allow the power to flow through the net to the coil. This is why the elements in a net must be connected. Each net must contain only one rung.

Use the Ladder Editor to:

- Place and connect Ladder Elements.
- Apply Compare, Math, Logic, Clock, Store, and Vector functions.
- Insert Function Blocks (FBs) into your program.
- Build program Modules and Subroutines, and use internal Subroutine Jumps and Labels.
- Place Comments on Ladder nets.

Ladder elements and functions may be dragged and dropped between nets. Hotkeys are also available for easy programming.

To start the Ladder Editor:

- Click the Ladder button on the toolbar.

For complete information, please refer to the .pdf manual: VisiLogic: Ladder Application Programming.
HMI Display Editor

Use the HMI Display Editor to create the Displays that the controller shows on its screen after the program is downloaded. When you click on HMI in the Project Explorer tree, a Display replica opens. The replica reflects the type of Vision controller you have selected in your project's Hardware Configuration.

Displays tell your operators what to do. You can have your operators log in with a password, enter setpoints and other data, and instruct the operator what to do in case of a system problem or alarm. A Display can contain both text and images. Text and images can be both fixed and/or variable. If the project is based on a touch-screen controller, you can also assign touch properties to on-screen objects.

Variables are inserted into a Display to:

- Show run-time values as integers
- Represent run-time values with either text, images, or bar graphs
- Show text messages that vary according to runtime conditions.

For complete information, please refer to the .pdf manual: VisiLogic: HMI Application Programming

The features in the HMI editor are determined by the controller type selected in Hardware Configuration. The next image is from a project based on an Enhanced Vision controller comprising a color touch screen.
**Color and Enhanced Vision**
When, in Hardware Configuration, you select an Enhanced or Color Vision, the HMI editor changes accordingly and shows additional options such as Frame and Button.

**About the HMI Display and Keypad**
All Vision controllers offer an integrated HMI operating panel that includes an LCD screen and a keypad. The screen size, type and keypad vary. Exact specifications regarding Vision operating panels are included in the user’s manuals.

'Touchscreen' controllers
There are different types of Vision touch-screen models:

<table>
<thead>
<tr>
<th>Monochrome LCD + HMI function keypad and virtual keypad</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum number of displays: 255</td>
</tr>
<tr>
<td>Maximum number of variables per display: 24</td>
</tr>
</tbody>
</table>

In these models, activate the virtual keypad by turning SB 22 Enable Virtual Keypad ON. This must be done at power-up, or before entering a Display containing a keypad variable. In addition, the Keypad entry variable must be assigned a Touch Property.

<table>
<thead>
<tr>
<th>Monochrome LCD + Virtual keypad only</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum number of displays: 255</td>
</tr>
<tr>
<td>Maximum number of variables per display: 24</td>
</tr>
</tbody>
</table>

In these models, the virtual keypad opens whenever the user touches a keypad entry variable that is currently displayed on the screen.
Variables

Variables enable you to show run-time values, text, images, and bar graphs on the controller’s screen in response to run-time conditions. Bit, or binary text variables, for example, display text messages on the controller’s LCD screen according to the status of a bit operand.

The **maximum number of variables per display** depends on the Vision controller division.

- Standard Vision: supports up to 24 variables
- Enhanced Vision: supports up to 255 variable

You can also use Keypad Entry Variables to enable an operator to enter a password, or data such as setpoints from the controller’s keyboard.

Variable Editor

When you insert a variable into a display, the Variable Editor opens, showing you the options that are relevant for that Variable.

Note that for some types of variables, the type of controller selected in Hardware Configuration may determine some of the variable's properties. For
example, touch-screen models enable you to assign Touch Properties to on-screen objects.

The next image shows a binary variable used in a V120 project.

The next image shows numeric variable options for touch-screen color models. These enable you to assign Touch Properties to on-screen objects, and offer options for depth and color.
### Variables Getting Started

After you have inserted Variables into a display, they are shown with that display in the Project tree.

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide</td>
<td>Causes the object/text to disappear from view</td>
</tr>
<tr>
<td></td>
<td>Suspends any touch properties</td>
</tr>
<tr>
<td>Disable</td>
<td>‘Greys’ a button object</td>
</tr>
<tr>
<td></td>
<td>Suspends any touch properties</td>
</tr>
<tr>
<td>Marking View</td>
<td>Changes the color of the button to dark blue background, white inverse text</td>
</tr>
<tr>
<td></td>
<td>Does not affect touch properties</td>
</tr>
<tr>
<td>Keypad OK</td>
<td>Turns ON when Keypad Entry value is within legal limits</td>
</tr>
<tr>
<td></td>
<td>Turns OFF when Keypad Entry value exceeds legal limits</td>
</tr>
</tbody>
</table>

Click a Display to show its Variables.
Quick Navigation
VisiLogic offers different tools for program navigation.

Program Tree

Project Navigation
Click an item to open it.
Right-click an object to view options

Note
Within the program tree, elements are presented alphabetically. This does not affect the order in which the program runs.

Ladder Modules and subroutines can be moved via drag-and-drop, as can HMI Modules and Displays. Again, moving elements does not affect the order in which they run. The Main Ladder Module, Main Subroutine, Start-up HMI Module and the Start-up HMI Display cannot be moved via drag-and-drop or erased. For easy identification, they are always marked in orange.
Go To Label

Use labels as bookmarks to mark program sections, and then locate them using the Go To Label \(<Alt> + <Right/Left arrow>\) and List of Labels \(<Ctrl> + <L>\) utility.

Forward-Backward

Use the arrows to scroll through the program areas you have visited during the session.

The Find utility also enables you to easily locate, directly open, and edit most program elements.

In addition, you can right-click many program elements to open a shortcut menu.

Downloading/Uploading a Project

The Download process transfers your project from the PC to the controller.

You can download a project via a direct PC-PLC connection, or via modem. Enhanced Vision controllers also support download via Ethernet and CANbus bridge.

1. Connect the controller to the PC with the MJ10-22-CS25 programming (communication) cable. Note that the V1040 supports download via a USB (Type A to mini-B) cable. COM port 1 function is suspended when the USB port is physically connected to a PC.
2. Click **Download** on the Standard toolbar, or select an option from the Connection>Download menu.

3. The downloading process begins.

Note that Build> Build All should be done before download, in order to locate project errors.

**Note**

Use Remote Access to establish a communication line via modem or network.

**Download options**

Vision controllers contain two types of memory:

- **RAM (Random Access Memory)**
  The controller uses RAM memory to run the application, make calculations, and manipulate data.
  RAM memory is volatile. This means that it requires power in order to maintain stored data.
  **Data stored in RAM:**
  The application, operand values, variable values, and Data Table sections that are not marked Part of Project.
  This data, as well as the RTC, is backed up by the battery.

- **FLASH (Flash Erasable Programmable Read-Only Memory)**
  The controller uses FLASH memory for data storage. and to store backup applications.
  FLASH memory is 'non-volatile'. It does not require power in order to maintain stored data.
  **Data stored in FLASH:**
  Data Table sections that are marked Part of Project and Back-up applications, including applications that can be uploaded.

**Backing up your application**

In order to make sure that your PLC can recover its application in the even of total power loss--including battery failure--you must back up your complete application in the FLASH memory. To do this, use one of the following options from the Connection>Download menu, which differ according to the Vision Division you controller belongs to:
### Creating an Upload application file

If the PLC contains an upload file, you can upload and edit it using VisiLogic. To create an upload file, use one of the following options from the Connection>Download menu:

- Standard Vision: Download (Ctrl + D)
- Enhanced Vision: Burn 'Upload Project' (Alt + Ctrl + B)

#### Reset Controller at Download

When you edit a project and download it to a controller that already contains this project, the controller may require reset after download. Reset is required when changes are made to:

- Hardware Configuration
- Data Table structure
- References to an HMI Display that does not exist in the project

In the following cases, the controller may request reset:

- If many changes have been made to subroutines or Displays.
- Changes in Power-up values

<table>
<thead>
<tr>
<th>Option</th>
<th>Comment</th>
<th>Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>Download</td>
<td>When you download an edited application to the PLC, select this option to download changes alone. If there are many changes, the PLC may request Reset. Standard Vision: This option burns an Upload file to the PLCs' FLASH memory. Enhanced Vision: This option does not burn an Upload file to FLASH. To create an upload file, select the option Burn 'Upload Project' (color only) (Alt + Ctrl + B)</td>
<td>Ctrl + D</td>
</tr>
<tr>
<td>Stop-Download-Run (Standard only)</td>
<td>Automatically returns PLC to RUN mode after download. If there are many changes, the PLC may request Reset.</td>
<td>Alt + Ctrl + D</td>
</tr>
<tr>
<td>Stop-Download-Reset</td>
<td><strong>Forces Reset after download.</strong></td>
<td>Alt + Ctrl + R</td>
</tr>
<tr>
<td>Download All &amp; Burn (Enhanced only)</td>
<td>Back ups the new application in the PLCs' FLASH memory. <strong>Forces Reset after download.</strong></td>
<td>Alt + Ctrl + A</td>
</tr>
<tr>
<td>Burn 'Upload Project' (Enhanced only)</td>
<td>Enables the entire project to be uploaded from the Vision PLC. <strong>Forces Reset after download.</strong></td>
<td>Alt + Ctrl + B</td>
</tr>
<tr>
<td>Download and See topic Download and Create Download file.</td>
<td>none</td>
<td></td>
</tr>
</tbody>
</table>
To upload a project from a controller:

1. Connect the controller to the PC.
2. Select **Upload** icon from the Connection menu; the Vision Communication PC Settings window opens.
3. Select the connection type and click Exit; the uploading process begins.

Upload copies the complete project from the controller into the PC.

Via Project Properties, you can apply upload and download options:

- Assign a project password. Password protection requires users to enter a password before uploading a project to a PC.
- Prevent project upload.

**Note**

Security restriction: if a PLC operator enters a wrong password 9 times, the PLC **automatically disables program upload** for that program.

- Resetting the PLC will enable you to try another 9 times.
- The limit set on password entry is intended to provide an additional layer of security. For example, this can prevent a hacking script from entering a networked PLC, since the number of attempts is limited and such a script would not reset the PLC.

Why can't I upload a project from the PLC?

- Project upload may have been disabled. In this case, the controller displays the following message at upload: "This project cannot be uploaded because:
  - the option 'Burn Upload Project' was not selected when the project was downloaded,
  or
  - due to incomplete data in the PLC", and upload fails.
- You are not entering the correct Upload password set in the Project Properties of this project.

Are **USB port adapters available**?

If your PC contains only USB ports, and your OPLC does not offer a USB port, you can connect a Unitronics OPLC via a compatible, external USB-to-serial converter.

Unitronics offers a USB-to-serial converter that has been tested for compatibility with OPLC controllers. This converter can be ordered from local Unitronics distributor, using part number MJ10-22-CS35.
On-Line Test Mode (Debug)

To test a project, first establish PC-PLC communications by connecting the controller to the PC with the MJ10-22-CS25 programming (communication) cable. Note that the V1040 supports download via a USB (Type A to mini-B) cable. COM port 1 function is suspended when the USB port is physically connected to a PC.

Note

You can also use Remote Access to establish a communication line via modem or network.

Once you have established communications, download the project and click the On-Line Test button. The Online Test toolbar opens, enabling you to:

- Switch between Run and Stop modes.
- Use Single Scan to run a single cycle of the ladder program for debugging purposes.
  You can stop the scan cycle at any point by placing OnLine Test Points, located on the More menu, in the Ladder.

When the scan reaches an OnLine test point that is active (receives RLO), Online Test freezes, enabling you to check element status and values, including Timer values, at that point during Ladder execution. Note that if more than one OnLine test point is activated, SB 35 turns ON.

- Measure the time interval between 2 points in the Ladder application, by placing Start and End Interval elements, located on the More menu, anywhere in the application. The time interval, units of 10 micro-seconds, is stored in the DW linked to the End Interval element. Note that Interval elements should not be placed in Interrupt routines.
Open Remote Access to debug remote controllers via network or modem connections.

In Online Test mode, you can view the power flow, and view and force operand values and element status. You can also select a controller that is directly connected to the PC, or a PLC's network ID # if the PC is linked to a CANbus or RS485 network.


Information Mode

Getting Started

- Force I/O, by right-clicking the operand and setting the desired state

Note • The controller can send and receive SMS messages when the controller is in Test mode.

Information Mode

Information Mode is a utility that is embedded in the operating system of the controller. Via Information Mode, you can view data on the LCD screen, use the controller's keyboard to directly edit data, and perform certain actions such as resetting the controller. You can enter Information Mode at any time without regard to what is currently displayed on the LCD screen.

Viewing data does not affect the controller's program. Performing actions, such as initializing the controller, can influence the program.

Note that when you use Information Mode, the keyboard is dedicated to that purpose. The keys return to normal application functions when you exit Information Mode.

Entering Information Mode

1. To enter Information mode:
   - **Non-touchscreen models**: press the <i> key on the Vision’s keyboard.
   - **Touchscreen models**: touch the screen in an area that is not occupied by a Keypad Entry variable or other screen object that has been assigned a Touch Property. Maintain contact for several seconds

2. The controller enters Information Mode and requests a password.

3. Enter your password. The default password is 1111. Note that at every power-up, this password is restored. To maintain a different password after power-up, use SB 2-Power-up as a condition to store the desired password value into SI 253.

   To change the password, access the controller via VisiLogic, then run On-line Test mode and changing the value. This value will be erased at power-up.

4. The controller enters Information Mode, showing the first category, Data Types. Use the <Enter> key to enter a category.
5. Press the <ESC> key to exit a category, and to exit Information mode.

The controller will block entry into Information mode until the correct password has been entered. This is why you must record any password you set for your controller.

The data in Information Mode is arranged in Categories. Each Category contains several Subjects. You navigate Information Mode by using the keyboard buttons.

To exit Information mode, press the <ESC> button on the Vision’s keyboard. Each press returns one level up. Press the number of times necessary to exit.

Notes: When you reenter Information Mode, the controller will return to the last Category viewed.

### Info System Operands

<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
<th>Turned ON</th>
<th>Turned Off</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>SB 36</td>
<td>INFO mode</td>
<td>Turns ON when Info Mode is entered by OS, Remote Access, or program</td>
<td>Turns OFF when user exits Info Mode</td>
<td>Delay time to enter Info Mode is 4 seconds, may be modified via SI 50</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
<th>Value</th>
<th>Comments</th>
</tr>
</thead>
</table>
| SI 50 | INFO Mode: Entry Delay Time | Default by O/S (every power up) = 4 seconds | Note that at every power-up, the default password to Info Mode, 1111, is restored. To maintain a different password after power-up, use SB 2-
Power-up as a condition to store the desired password value into SI 253. The password may also be modified by accessing the controller via VisiLogic, then running On-line Test mode and changing the value. This value will be erased at power-up. |
| SI 253 | Password: Info Mode         | Note that at every power-up, the default password to Info Mode, 1111, is restored. To maintain a different password after power-up, use SB 2-
Power-up as a condition to store the desired password value into SI 253. The password may also be modified by accessing the controller via VisiLogic, then running On-line Test mode and changing the value. This value will be erased at power-up. |
The categories of available information depend on the controller model. The table below shows the basic categories of information.

<table>
<thead>
<tr>
<th>Category</th>
<th>Subject</th>
<th>Possible Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Types</td>
<td>Memory Bits</td>
<td>• View bit status</td>
</tr>
<tr>
<td></td>
<td>System Bits</td>
<td>• Change bit status (Set/Reset)</td>
</tr>
<tr>
<td></td>
<td>Memory Integers</td>
<td>• View integer/long integer/double word value.</td>
</tr>
<tr>
<td></td>
<td>System Integers</td>
<td>• Change values</td>
</tr>
<tr>
<td></td>
<td>Memory Longs</td>
<td>• Toggle Base: view the value in decimal or hexadecimal form.</td>
</tr>
<tr>
<td></td>
<td>System Longs</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Memory Double Words</td>
<td></td>
</tr>
<tr>
<td></td>
<td>System Double Words</td>
<td></td>
</tr>
<tr>
<td></td>
<td>TCP/IP (Standard Vision, Visible when Ethernet card is installed)</td>
<td>Enables you to view and edit IP address and socket settings.</td>
</tr>
<tr>
<td></td>
<td>System</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Model &amp; O/S Ver</td>
<td>• Check the controller’s model number and operating system version.</td>
</tr>
<tr>
<td></td>
<td>Working Mode</td>
<td>• Check whether the controller is in Run or Stop mode.</td>
</tr>
</tbody>
</table>
Reset the controller. This restarts your program; restoring power-up values to all data types except for those protected by the battery backup. The battery protects Real Time Clock (RTC), all operand, and Data Table values.

Initialize the controller. This restarts your program and initializes all values, restoring 0 values to all data types.

**Time & Date**

- View the Real Time Clock (RTC) settings. Note that the RTC settings control all time-based functions.
- Change the RTC settings via the controller’s keyboard.

**Unit ID**

The Unit ID number identifies a networked controller. You can:

- Change the ID number. The new ID number will remain in effect until the controller is reset.
- Burn the ID number into the controller’s FLASH memory. This is a permanent change.

**Serial Port 1**

- View and edit communication settings.
- Select to Change or Burn the new settings.

**Serial Port 2**

**Ethernet (Enhanced Vision, if an Ethernet card is installed)**

- Enables you to view and edit IP address, Socket settings, and other TCP/IP settings.

**Monitor Communications (Enhanced only)**

This is a built-in communications 'sniffer'

- Touch screen models: select Serial or Ethernet, then press Monitor. Note the button that allows you to toggle between Hex and ASCII
- Non-touch screen models: Select Communication, then select Serial or Ethernet> COM Buffer. Use F2 to toggle between Hex and ASCII. In addition, press Enter, and then the Down key to toggle between Tx and Rx.

**CANbus**

- Built-in CANbus communications 'sniffer'
- Change the CANbus baud rate.

**Touchscreen (Touchscreen models only)**

- Enables you to calibrate the touchscreen, if it is not responding accurately to screen taps.

**SD Card (Enhanced Division)**

- Removable memory storage

- Enables you to upload and download VisiLogic applications, OS firmware, and Data Table data from/to an SD card.
- You can use these features to 'clone' a PLC application.

**Function**

Reserved for
COM Ports and Data Communications

Information regarding the communications features of specific Vision models is available from your local Unitronics distributor, or export@unitronics.com.

Below is a general description of Vision communication features. For details, refer to the VisiLogic - Communications manual.

---

### Com Ports

#### Serial

All Vision controllers comprise RS232 serial communication ports. RS232/RS485 adaptors are available by separate order. Certain models, such as the Vision120, support both RS232 and RS485. For details on communications hardware settings, refer to the User Guides and documentation supplied with relevant models.

#### CANbus

Separate CANbus ports are built into specific controller models.

#### Ethernet

Ethernet ports are available by separate order.

---

**Note**

- All ports can be used simultaneously. For example, a single controller may use one serial port to send messages to a modem via RS232, another port to communicate with a frequency converter, while the controller engages in communications via its CANbus port.
- Standard programming cables do not provide connection points for pins 1 and 6.

---

### Initializing COM ports

- Serial and CANbus communication ports must be initialized in your control program using the COM Init FB, located on the FB’s menu.
- The Ethernet port must be initialized using the Ethernet Card Init FB, located under Ethernet on the FB’s menu.
Data Communications include all of the options shown below:

- CANbus
- Modems, Landline and GSM/GPRS
- GPRS
- Ethernet
- DF1 Slave (Allen-Bradley)
- RS232
- RS485 Options

Communication FBs

- SMS messaging
- GPRS
- MODBUS (serial)
- MODBUS IP (Ethernet)
- Communications Protocol FB

PC-Vision communications

- PC-Modem Configuration
- Remote Access: Accessing a PLC via PC
- Accessing a Networked PLC via PC

SD Card Remote Access

SD Card Explorer

About Modems

Unitronics' controllers can be hooked up to PSTN (landline), or GSM/GPRS modems via the RS232 COM port. Unitronics provides kits that comprise modems that have been tested by Unitronics and are supported for use with Vision, Jazz, and M90/91 PLCs.

Before you can use modems in your application, **you must use Modem Services to initialize both the PC and PLC-side modems.** This process is referred to as 'Prepare Modem'.

Modem services

Modem Services is located on the Connections menu.

To use Modem Services, connect the modem to a PC, using the **cable supplied by the modem manufacturer.** You can then initialize the modem.

Once you have connected initialized modems to your PC and PLC, you can use Modem Services to establish communications with a remote PLC.

PC-side Modems

You can use a PC modem to access a remote, modem-linked controller and perform any task, just as you would if the PLC were directly connected to your PC. For example, you can:

- Dial a remote PLC modem and receive calls from a PLC.
- Download, upload, and edit the controller program via the modem connection.
- Run Online test mode.
- Download an OS to the controller via modem.
- Use OnLine test and Information Mode to troubleshoot problems in remote controllers and applications.
- Read and write data to/from controllers via Remote Access or Unitronics' communication .dll utilities.
- Receive and send SMS messages via SMS options.
PLC-side modems

Via modem, a Vision controller can communicate data using:

- MODBUS (serial) commands.
- VisiLogic's Communication Protocol FB, which enables Vision controllers to communicate data with most external serial devices, such as bar-code readers and frequency converters, via their proprietary protocols.
- SMS messages. The SMS FB enables text messages, including variable data, to be sent and received via GSM modems.
- e-mail via GPRS (Enhanced Vision only).
- GPRS cellular network, to transmit IP packets of data.

Modem Tips

Notes

- The PC-modem cable is not the same type of cable used to connect between the controller and the modem. Ensure that the cable used to connect the PC to the modem provides connection points for all of the modem's pins.

- If calls are routed via a switchboard, note that the switchboard settings may interfere with communications. Consult with your switchboard provider.

- If, within the modem initialization strings, the parameter S7 is too short to permit the PLC's modem to answer, an error will result. For example, if this parameter is set as S7=30, the PC modem will wait for 3 seconds to receive an answer from the PLC's modem. If the PLC modem does not answer before the 3 seconds have elapsed, the S7=30 parameter is exceeded, and the PC modem returns the No Carrier error.

- PC/PLC modem communications: Both PC and controller must use the same type of modem: either landline or GSM. Internal PC modems must be used in conjunction with the driver provided by the modem's manufacturer.

- **Standard Vision Division**
  Controllers in this division can only support a single modem. You can connect a modem to any COM port. However, note that SB 184 TX Success and SB 185 TX Failed indicate message transmission status regardless of the actual COM port connected to the modem.

- **Enhanced Vision Division**
  Controllers in this division can support a modem on each COM port. Each port is linked to a Succeed and Fail SB: COM1: SB 184 and SB 185, COM2: SB186 and SB 187, COM3: SB 188 and SB 189.
When working with V570 and V290 (color):
- Set the baud rate in both Modem Services and in COM Init to 57600. In addition, run the Prepare PLC Modem procedure with the baud rate set to 57600.
- Com Init:
  - Select Ignore Break
  - Time Out Reply: set to a minimum of 6 seconds.

Known compatibility issue: Sony Ericsson Modems. Unitronics products are compatible with the following Sony Ericsson Modems:
- Model GT47 R5xxxx and higher
- Model GM29 R6xxxx and higher
Unitronics cannot guarantee compatibility with other models, such as Sony Ericsson Modem model GM29 R4xxxx.
Hardware Configuration

Hardware Configuration opens automatically when you first create a new project. In order to open Hardware Configuration in an existing project, either select Hardware Configuration from the View menu or click the button on the toolbar.

Click on the appropriate icon to select the model Vision, the Snap-in I/O module, and any I/O Expansion modules required by your application.

After you select the Snap-in or Expansion I/O modules connected to the controller, you can configure inputs: analog, digital, and high-speed counter/shaft-encoder/frequency measurers and PT100; and outputs: analog, digital, and PWM high-speed outputs.

Note: You must select the correct Vision model and Snap-in I/O modules before downloading your project.

To avoid exceeding the I/O capacity of your controller, check the I/O report at the bottom of the Hardware Configuration window.

I/O Expansion Modules

Vision controller are compatible with I/O Expansion modules.

There are three ways to integrate them into the system:

- Locally, via an EX-A1 adapter connected to the controller's I/O Expansion port
  - A Vision controller can support up to 8 local I/O Expansion Modules
connected to the I/O Expansion port.

- Remotely, via an EX-RC1 connected to the controller's CANbus port.
- Directly to the controller's I/O Expansion port, using an EX90-DI8-RO8 stand-alone I/O Expansion module. Note that only a single EX90-DI8-RO8 can be connected to the controller. Check with your distributor for additional details.

Configuring I/O Expansion Modules

Use Hardware Configuration to add modules and configure the I/Os, and to remove modules from the system. The I/O Report at the bottom of the screen tracks the I/O capacity of the system.

**Note**: Most I/O Expansion Modules require an adapter. Check with your distributor for additional details.

**Addressing I/Os on Expansion Modules**

Inputs and outputs located on I/O expansion modules are assigned addresses that comprise a letter and a number. The letter indicates whether the I/O is an input (I) or an output (O). The number indicates the actual physical location of the I/O. This number relates to both the position of the expansion module in the system, and to the position of the I/O on that module.

Expansion modules are numbered from 0-7 as shown in the figure below.
The formula that is used to calculate the number of the I/O is:
$$32 + x \cdot 16 + y,$$
where $X$ is the number representing the location of the module’s location (0-7) and $Y$ is the number of the input or output on that specific module (0-15).

**Examples**
- Input #3, located on module #2, will be addressed as I 67
  $$67 = 32 + 2 \cdot 16 + 3$$
- Output #4, located on module #3, will be addressed as O 84
  $$84 = 32 + 3 \cdot 16 + 4.$$ 

**Remote I/Os**
The EX-RC1 enables you to distribute I/O Expansion Modules throughout your system. The adapter is connected to a master PLC by UniCAN, Unitronics’ proprietary CANbus protocol, and functions as a slave device within that network. Each adapter may be connected to up to 8 I/O expansion modules. The network may include up to 60 devices.

The EX-RC1 is run by a factory-installed VisiLogic application. You can upload this application and tweak it to adapt it to your system.

Note that the adapter has the ability to auto-detect digital I/O Expansion modules that are connected via CANbus. This means that if your system includes only digital I/O Expansion Modules, you do not have to define the Hardware Configuration.
If, however, your system includes analog modules, you must upload the VisiLogic application from the EX-RC1 and define the Hardware Configuration.

The EX-RC1 network ID number is determined by DIP switch settings, and cannot be changed by the software application. The switch setting represents the ID number as a binary value as shown in the following figures.

<table>
<thead>
<tr>
<th>Unit ID</th>
<th>1</th>
<th>2</th>
<th>55</th>
<th>15</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings</td>
<td><img src="image1.png" alt="Settings" /></td>
<td><img src="image2.png" alt="Settings" /></td>
<td><img src="image3.png" alt="Settings" /></td>
<td><img src="image4.png" alt="Settings" /></td>
</tr>
</tbody>
</table>

**Configuring a PT100 Input**

1. Click on a line

2. Click Selected

3. Select Operand type and address.

4. Assign a description.

5. Select Decimal or Hexadecimal.

6. To assign a Power-up value, click on the check box to enable the Power-up field, then enter the value.

7. The analog input data appears in place.
High-Speed Counters: I/O Expansion Modules

Certain digital inputs on certain I/O Expansion Modules are high-speed inputs that can be used as a 16-bit high-speed counter of the following types:

- **High-Speed Counter**: Uses the high-speed counter input alone, without reset.
- **High-Speed Counter with Reset**: Uses the High-Speed counter input and the next-to-last digital input as the counter’s reset. Note that Reset occurs during Active High.
- **Frequency Measurer**: Counts the number of pulses over the selected period of time (sample rate): 100 mSec, 500 mSec, or 1000 mSec (1 second), expressing the number in Hertz. For example, 155 pulses counted over 500 mSec is equal to 310Hz.

**Configuring a High-Speed Counter**

1. Open an Expansion Module by clicking it on the DIN rail.
2. Select High Speed Inputs.
3. Select the desired type of High-speed counter.
4. Link an operand to contain the counter value.

The linked operand contains the counter value which is current at the last program scan. Use this operand in your program like any other.
High-Speed Counters: Snap-in I/O Modules

Certain digital inputs on Snap-in I/O Modules are high-speed inputs that can be used as a 32-bit high-speed counter of the following types:

- **High-Speed Counter** Uses the high-speed counter input alone, without reset.
- **High-Speed Counter with Reload** Uses the High-Speed counter input and an additional digital input as the counter’s reset. You can select whether Reload occurs at Active High, when the pulse is at the positive level, or Active Low, when the pulse is at the negative level. Note that you cannot set the Reload input to Frequency Measurement.
- **Frequency Measurer** Counts the number of pulses over the selected period of time (sample rate): 100 mSec, 500 mSec, or 1000 mSec (1 second), expressing the number in Hertz. For example, 155 pulses counted over 500 mSec is equal to 310Hz.
- **Shaft Encoder** Note that pnp shaft-encoder devices may be used.
Configuring a High-Speed Counter

1. Open a Snap-in I/O Module by clicking it.
2. Select High-Speed Inputs.
3. Select the desired type of high-speed counter.
4. Link an operand to contain the counter value.

The linked operand contains the counter value which is current at the last program scan.

To measure frequency, click the second input field and select the sample rate.

1. Select the sample rate.
2. Link an operand to contain the frequency value.
High-Speed Counter: Reload

Reload enables you to **immediately** load 0 into a high-speed counter when the counter value reaches a target value. Note that you cannot set the Reload input to Frequency Measurement.

Stepper via High-speed Output (V570/V1040 only)

If you are using a V570 or V1040 with any model Snap-in I/O module, VisiLogic 7.00 or higher and the OS released with that version, you can use specific high-speed outputs to control stepper motors.

Note that any acceleration and deceleration that is needed to arrive at Target safely and accurately must be implemented in your Ladder application.

Configuring the HSO

1. Click the Output line and select High Speed Outputs (Step Control).

2. The Select Operand and Address dialog box appears five successive times, allowing you to link operands for Frequency, Duty Cycle, Run, Current Position, and Target Position.
### Parameter Configuration

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency</td>
<td>MI, ML, DW</td>
<td>Note that $F = \frac{1}{T}$, where $T$ is the duration time of a complete cycle. Frequency settings differ from npn to pnp output type.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- npn: You can use a value of 0, or a value from 8-50000Hz (50kHz).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- pnp: You can use a value of 0, or a value from 8-2000HZ. Other frequency values are not supported.</td>
</tr>
<tr>
<td>Duty Cycle</td>
<td>MI, ML, DW</td>
<td>The ratio of the &quot;on&quot; period of a cycle to the total cycle period. This value may be from 0-1000, and is expressed as a percentage.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If, for example, the constant 750 is stored into the Duty Cycle operand, the duty cycle is equal to 75.0%. This means that the pulse will hold a positive state during 75.0% of the total cycle.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>In the figure below, <strong>MI 22 Duty Cycle Value</strong> is equal to 250. This results in the duty cycle being 25% of the total cycle time.</td>
</tr>
<tr>
<td>Run</td>
<td>MB</td>
<td>Changes the operating mode of the output from normal output mode to HSO mode: 0 (SET)=Normal Mode, 1 (RESET): HSO Mode.</td>
</tr>
<tr>
<td>Current Position</td>
<td>DW</td>
<td>This is the current location of the stepper.</td>
</tr>
<tr>
<td>Target</td>
<td>DW</td>
<td>This is the location you want the stepper to move to.</td>
</tr>
</tbody>
</table>
Acceleration and Deceleration
If your application requires acceleration/deceleration as is shown in the accompanying figure, you can control the speed of movement via the Ladder application. To see how, check the sample application Stepper Control.

Configuring a High-Speed Counter
Certain digital inputs on both Snap-in I/O and I/O Expansion modules can be used as high-speed counters in the following modes:
- High-Speed counter
- High-Speed counter with Reset
- Shaft encoder
- Frequency Measurer

Note: When you select High-Speed Counter with Reset, the controller uses an additional input for reset; shaft encoders also require the use of two inputs.

High-speed counters are built into the hardware, you define them as part of the controller's hardware configuration by first selecting the counter type and then linking it to an operand that contains the counter value.

Compare Functions and Counter Values
The high-speed counter value is read once during every program scan. For this reason, do not use the Equal (\(=\)) function together with high-speed counter values. If the counter does not reach the value required by the Equal function during the actual program scan, the function cannot register that the value has been reached. Use functions Greater Than Or Equal To (\(\geq\)) and Lesser Than Or Equal To (\(\leq\)).

Configuring a High-speed Output (PWM)
You can use certain outputs as High-speed Outputs (HSO) via PWM (Pulse Width Modulation). When you select a High Speed Output in the Hardware, the Select Operand and Address dialog box appears three successive times, allowing you to link operands for the following values:
- Duty Cycle
  The ratio of the "on" period of a cycle to the total cycle period. This value may be from 0-1000, and is expressed as a percentage.
If, for example, the constant 750 is stored into the Duty Cycle operand, the duty cycle is equal to 75.0%. This means that the pulse will hold a positive state during 75.0% of the total cycle.

- **Frequency (F)**
  Note that $F = \frac{1}{T}$, where $T$ is the duration time of a complete cycle. Frequency settings differ from npn to pnp output type.
  - npn: You can use a value of 0, or a value from 8-50000Hz (50kHz).
  - pnp: You can use a value of 0, or a value from 8-2000HZ. Other frequency values are not supported.

- **Run**
  Changes the operating mode of the output from normal output mode to HSO mode:
  0 (SET) = Normal Mode, 1 (RESET): HSO Mode.

In the figure below, **MI 22 Duty Cycle Value** is equal to 250. This results in the duty cycle being 25% of the total cycle time.

**Note**
If values out of range enter the Duty Cycle and Frequency operands, the output turns OFF and remains OFF until the values re-enter the range.

**Configuring the HSO**

1. Click on a line.
2. Select PWM mode.
### Configuring a High-speed Output (PWM)

**Hardware Configuration**

3. Select Operand type and address.

4. Assign a description.

5. Select Decimal or Hexadecimal.

6. To assign a Power-up value, click on the check box to enable the Power-up field, then enter the value.

7. Link an operand to contain the Frequency Value.

8. Link an operand to turn the PWM on and off.

9. The output appears with all three linked operands.

<table>
<thead>
<tr>
<th>Op</th>
<th>Addr</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MI</td>
<td>22</td>
<td>Duty Cycle Value</td>
</tr>
<tr>
<td>MI</td>
<td>23</td>
<td>Frequency Value</td>
</tr>
<tr>
<td>MB</td>
<td>22</td>
<td>Stepper</td>
</tr>
</tbody>
</table>

**Note**

V120: The same MI sets Frequency for both outputs.
Configuring an Analog Input

Before you can use an analog input in your program, you must link it to an operand. An analog input value can be contained in an MI, ML, or DW.

1. Click on a line.
2. Select a range.
3. Select Operand type and address.
4. Assign a description.
5. Select Decimal or Hexadecimal.
6. To assign a Power-up value, click on the check box to enable the Power-up field, then enter the value.
7. The analog input data appears in place.

Analog Filters, PLC

Analog filter options, defined in Hardware Configuration, are available in Vision120, V200-18-E3B, and certain I/O expansion models that offer analog inputs, such as the IO-ATC8. Note that 10-bit inputs do not offer filters.

Using a filter can help protect your system from fluctuating input readings. The filter processes values on a FIFO (First In First Out) basis. The filtering process is run after each new analog reading. Values can be processed further via the Filter FB.

The Filter field, shown below, is activated after you define the analog input.
Details regarding an I/O's specific resolution, conversion methods, and rates are given in the technical specifications supplied with Unitronics' controllers and I/O modules.

When you configure an analog input for use with the PID function, ensure best results by using the highest strength filter.

### Filter Types

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low</td>
<td>Calculates the average of the last two readings</td>
</tr>
<tr>
<td>Medium</td>
<td>Takes the last 4 readings, eliminates the lowest and highest values, then calculates the average of the 2 remaining values.</td>
</tr>
<tr>
<td>High</td>
<td>Takes the last 8 readings, eliminates the two lowest and the two highest values, then calculates the average of the 4 remaining values.</td>
</tr>
</tbody>
</table>
Configuring an Analog Output

1. Click on a line.

2. Select a range.

3. Select Operand type and address.

4. Assign a description.

5. The analog output data appears in place.

Analog I/O Ranges

Note that devices used in conjunction with the controller must be calibrated according to the available range. Below, Range refers to the value contained by the register that is linked to the I/O in Hardware Configuration.

<table>
<thead>
<tr>
<th>Model number</th>
<th>Resolution</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>V200-18-E1 (Snap-in I/O module)</td>
<td>10 bit (0-10V, 0-20mA, 4-20mA)</td>
<td>0-1023, 1024 units (except at 4-20mA)</td>
</tr>
<tr>
<td>V120-12-R1, V120-12-R2C</td>
<td>M90 controllers (analog input)</td>
<td>M91-19-R1, M91-19-R2, R2C</td>
</tr>
<tr>
<td>V120-12-UN2</td>
<td>M90-19-UN2</td>
<td>M91-19-TC2</td>
</tr>
<tr>
<td></td>
<td>14 bit (0-10V, 4-20mA)</td>
<td>Temperature</td>
</tr>
</tbody>
</table>
### Analog I/O Ranges

#### Hardware Configuration

<table>
<thead>
<tr>
<th>Model number</th>
<th>Type</th>
<th>Input ranges</th>
<th>Analog Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>V120-12-UN2</td>
<td>mV</td>
<td>-5 to 56mV</td>
<td>-500 to 5600</td>
</tr>
<tr>
<td>M90-19-UN2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>M91-19-TC2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TC type</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>B</td>
<td></td>
<td>200 to 1820° C (300 to 3276° F)</td>
<td>2000 to 18200 (3000 to 32760)</td>
</tr>
<tr>
<td>E</td>
<td></td>
<td>-200 to 750° C (-328 to 1382° F)</td>
<td>-2000 to 7500 (-3280 to 13820)</td>
</tr>
<tr>
<td>J</td>
<td></td>
<td>-200 to 760° C (-328 to 1400° F)</td>
<td>-2000 to 7600 (-3280 to 14000)</td>
</tr>
<tr>
<td>K</td>
<td></td>
<td>-200 to 1250° C (-328 to 2282° F)</td>
<td>-2000 to 12500 (-3280 to 22820)</td>
</tr>
<tr>
<td>N</td>
<td></td>
<td>-200 to 1300° C (-328 to 2372° F)</td>
<td>-2000 to 13000 (-3280 to 23720)</td>
</tr>
<tr>
<td>R</td>
<td></td>
<td>-0 to 1768° C (-32 to 3214° F)</td>
<td>-0 to 17680 (-32 to 32140)</td>
</tr>
<tr>
<td>S</td>
<td></td>
<td>-0 to 1768° C (-32 to 3214° F)</td>
<td>-0 to 17680 (-32 to 32140)</td>
</tr>
<tr>
<td>T</td>
<td></td>
<td>-200 to 400° C (-328 to 752° F)</td>
<td>-200 to 4000 (-3280 to 7520)</td>
</tr>
<tr>
<td>IO-PT4</td>
<td></td>
<td>-50° to 460°C</td>
<td>-500° to 4600°C</td>
</tr>
</tbody>
</table>
Working with Analog I/O Values

Analog values can be converted to physical values, for example Engineering Units (EU) such as degrees Celsius, by using the Linearization FB.

Note: Analog I/O values are contained in the register that you link to the I/O in Hardware Configuration.

Linearizing an Analog Input Value
Linearizing an Analog Output Value

Working within the 4-20mA range

Available ranges, according to controller and I/O module, are shown in the topic Analog I/O ranges. Note that devices used in conjunction with the controller must be calibrated accordingly. In the examples below, the analog device is a pressure transducer; values are therefore translated to millibars.

10-bit Analog Input, V200-18-E1

12-bit Analog Input, IO-A14-AO2
Hardware Configuration

Configuring Digital Inputs

Note

12-bit Analog Output, IO-A14-AO2

14-bit Analog Input, V120-12-UN2

Configuring Digital Inputs

Note •  PNP/NPN must be set within the hardware, as explained in the technical specifications supplied with the I/O module. The program settings do not influence the actual hardware input setting.
Configuring Digital Outputs

Digital Outputs may be Relay or Transistor type.

**Note**  
PNP/NPN must be set within the hardware, as explained in the technical specifications supplied with the I/O module. The program settings do not influence the actual hardware input setting.
You can also assign a single description to several lines.

**Assign a Description to Multiple Operands**

To assign a Description to multiple operands, select a range of operands by dragging your cursor across them, then type a description and click OK.

You can also copy and paste text to and from other Windows applications.
Controller Settings

Vision Communication PC Settings

This defines the connection VisiLogic will use when downloading a program or carrying out other communication tasks. To display the current communication settings, select Communication & OS from the Connection menu.

Note that you can cause the Unit ID# to be permanently assigned to the project via Project Properties.

<table>
<thead>
<tr>
<th>Select Connection Type</th>
<th>If your Vision contains an Ethernet port, you can select the TCP/IP options. Serial is the default communication mode; note that if you select TCP/IP and close the project, the setting reverts to Serial.</th>
</tr>
</thead>
<tbody>
<tr>
<td>PC COM Parameters</td>
<td>Port, Retries and Time-Out are the communication settings between VisiLogic and the controller. Note • If you are working with a network, the TimeOut should be greater than 1 second. • If you are working with a GPRS modem, set the TimeOut to its maximum of 10 seconds.</td>
</tr>
<tr>
<td>Communicate with OPLC</td>
<td>Use these options to communicate with networked controllers. Direct Connection: select this to communicate with any controller that is connected to your PC via the download cable, including a network bridge. Within Network: select this to communicate with a controller that is integrated into a network, then select the controller's ID number Note • ID numbers 1-63 are reserved for controllers linked via CANbus; ID numbers 64-127 are reserved for controllers networked via RS485. Using this range of ID numbers prevents a polled controller from attempting to act as a CANbus bridge, preventing it from attempting to locate the requested controller.</td>
</tr>
<tr>
<td>Vision OPLC Information</td>
<td>Click Get OPLC Information to display information about the controller you have selected in Communicate with OPLC.</td>
</tr>
</tbody>
</table>
Communication and OS-Controller Menu

Via this menu, you can

- Set PC communication parameters (non-modem) to enable PC-PLC communication.
- Reset and initialize a PLC, enter Stop and Run modes, get RTC values as well as reset the RTC.
- Get COM Parameters and PLC status.
- Install an Operating System (O/S) in a PLC
- Check Network Status

Run, Reset, Initialize

When you click one of the buttons shown in the figure below, your PC will access the controller selected in Communicate with OPLC.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set RTC</td>
<td>These are the values of your PC’s clock. Click Set RTC to import these values into the RTC of the controller.</td>
</tr>
<tr>
<td>Get Vision RTC Current Values</td>
<td>Click to view the current PLC settings</td>
</tr>
<tr>
<td>Run</td>
<td>Click to run the current program in the PLC.</td>
</tr>
<tr>
<td>Stop</td>
<td>Click to stop the current PLC program.</td>
</tr>
<tr>
<td>Reset</td>
<td>Click to reset the PLC, and reinstall any values preset in the program, such as Timers.</td>
</tr>
<tr>
<td>Reset &amp; Initialize</td>
<td>Click to reset, reinstall any preset values, and initialize all memory operands</td>
</tr>
</tbody>
</table>
Get COM Parameters and PLC status

Select Get to view communication parameters and PLC status in the controller you are currently communicating with. This is the controller selected in Communicate with OPLC.

Downloading an OS

In many cases, you must update the controller's Operating System, or OS, before you can take advantage of newly released Vision and VisiLogic features. You can download an OS, via a direct PC-PLC connection, or via modem. Enhanced Vision controllers also support download via Ethernet and CANbus bridge.

Note: You cannot download an OS via a network connection.

To download an OS via a direct PC-PLC connection:

1. Connect the controller to the PC with the MJ10-22-CS25 programming (communication) cable. In the case of the V1040, the USB cable may be used.

   Note: The controller's COM Port 1 must be directly connected to the PC via the programming cable. Only COM Port 1 can be used to download an OS. In the case of the V1040, note that COM port 1 function is suspended when the USB port is physically connected to the PC. Direct Connection must be selected in Communicate with OPLC.

2. Open Connection>Communication & OS, and then click the fourth tab to open Install Operating System.

3. Click Check to enable VisiLogic to establish communications with the PLC and check the version of the OS currently installed in the PLC; after the check is complete, VisiLogic displays the OS version currently installed in
4. To install the OS, click Download; OS installation begins.

5. If you are connected to a Vision Color Series model such as the V570, a wizard opens and guides you through the steps. Note that the Advanced button enables you to download separate OS sections; this feature is intended for use by advanced users only.

**Note** • By default, OS version shows the most recent OS version released with your version of VisiLogic. To check if more recent OS versions are available, run Live Update from the Web. Note that Live update does not install the new operating system, which must be installed as described above.

• You can also install an older OS version by selecting an OS version via the drop-down arrow, and then clicking Download.

• System Fonts are used by the controller to show system messages that are not part of your program, such as a message that the controller is in Stop Mode. These fonts are part of the OS, and do not need to be downloaded separately.

• The first number in the OS number is the main version number, followed by the sub-version and Build number.

You can check to see if new OS versions have been released using Live Update, via Help>Check for Updates>Operating System.

**Application Version Mismatch (Err - Old Topic)**

After OS download, the PLC may display one of these messages. This message appears when base versions of the OS and of VisiLogic do not match, for example, OS version 3.5x / VisiLogic version 3.6x, or from OS 4.5x to VisiLogic 4.0x. This means there is an incompatibility between the VisiLogic version of the project in the controller and the OS.
This error can generally be resolved by downloading a new VisiLogic project updating the current project to the most recent version of VisiLogic. You can also update the project currently in the PLC by uploading it, updating it, and then downloading it to the PLC.

**Known Issue, Vision 120**

Known issue: A power failure during OS download causes V120 models, installed with bootstrap (firmware) 1.30 and lower, to enter bootstrap mode. The V120 will not be able to exit Bootstrap mode until it is physically turned off and then powered on.

**Download an OS via Modem**

By following the recommendations given below, you can successfully download an OS to a Vision controller via modem. Download via modem is supported by OS V3.70, B50 and higher.

In order to download an OS via modem:

1. Prepare and connect the PLC-side modem as described in the topic PLC-side Modems, in the section 'How to enable a controller to communicate via landline or GSM/GPRS modems'. These procedures initialize the modem with the parameters required to download an OS.

2. Connect the modem to COM port 1 on the PLC.

If power failures occur, or if the modem communication link is broken, the OS download stops. Controllers V230, 260, and 280 can recover without any intervention; as can V120 controllers installed with bootstrap Version 1.30 or higher.

However, a V120 controller installed with bootstrap versions lower than 1.30 may require physical power-up (must be turned off and then powered on.)

In all cases, it is recommended that someone be next to the PLC during the OS download in order to attend to any potential problems.

The PC-side and PLC-side modems must use the initialization defaults: baud rates must be set to 9600; and COM Init set to ATS0=1.

Once the PC-PLC modem connection has been established, proceed according to the instructions in Downloading an OS.

**Modem Tips**

To avoid compatibility problems, use modems produced by the same manufacturer and of the same model. This is due to lack of standardization between modem manufacturers, which may result in communication conflicts.

**Check CANbus Network Status**

The network status is checked via the bridge. Access Check Network Status by opening the Connection menu, selecting Communication & OS, then clicking the network tab.
1. Drag your cursor across the units you want to check.

2. Click Start Check.

3. Status is shown according to these color codes.
Remote Access

Remote Access: Accessing a PLC via PC

Use VisiLogic to activate access a remote Vision controller and:

- Download and upload projects
- Remotely operate the controller's HMI through your PC
- Run On-Line Test mode on the remote controller
- Run Information Mode.

You can access:

- Stand-alone controllers that are directly connected to the PC via a cable.
- Controllers within a CANbus or TCP/IP network
- Either stand-alone or networked controllers via GSM or landline modem.

In addition to using VisiLogic to access a remote Vision, Unitronics provides a stand-alone utility called Remote Access. This utility can also access Unitronics M90/91 and Jazz controllers. It may be freely downloaded from http://www.unitronics.com.

Accessing a PLC via VisiLogic

Before you can access a controller, you must establish a communication link:

Direct Connection: PC-Controller

1. Connect your PC to any controller using the programming cable supplied with the controller kit.
   In the case of the V1040, the USB cable may be used; note that COM port 1 function is suspended when this port is physically connected to a PC.
Accessing a Networked Controller

1. Connect your PC to any controller in the network using the programming cable supplied with the controller kit.

   ![Diagram of network connection](image)

   **Note**

   Different PCs can access a network at the same time, using different controller units as bridges. However, 2 different PCs cannot simultaneously access the same controller unit.

2. Select a networked controller by opening Communication & OS from the Connection menu, and then entering the Unit ID number.
1. Prepare and connect your PLC-side modem as described in the topic PLC-side Modems, in the section 'How to enable a controller to communicate via landline, GSM/GPRS modem'.

2. Prepare the PC-side modem as described in the topic PC-Side Modems (Modem Services), in the section 'How to Configure a PC-side Modem'.

3. Via Connection>Modem Services, dial the remote PLC's controller to establish the data link.

4. Select a connection type using the drop-down selection box on the toolbar.

5. Click the On-line Test mode button or press <F9> to enter On-Line Test mode; the left Ladder rail turns red and real-time values are displayed in the Output window.

6. Click the Remote Access button on the On-line Test toolbar to display the remote controller on your PC screen. You can toggle the controller image on and off using <Shift>+<F9>.
7. Remotely operate the controller's HMI by using:
   - Your PC keyboard, pressing arrow, alphanumeric, and function keys <F1> to <F8>). Note that the Vision <ESC> key is the <E> key on the PC keyboard
   - Your mouse to click keypad keys on the Remote Access image on the PC screen. In the case of touch-screen models, you can also click on-screen objects.

   To enter Information Mode, press the <i> key on your PC keyboard, or by clicking it on-screen with your cursor.
Remote Access options

Use the options to set display options and refresh rate.

Note • The Zoom option can be activated only if you select Hide Keys. Zoom cannot be used with or V280 controllers.

Improving Remote Access run times:

Cache files enable Displays to load more quickly. These files enable Remote access to refer to HMI elements stored in the PC, instead of taking them from the PLC. If you have been provided with a static HMI file, select it to improve Remote Access run times.

Monochrome Vision only

• To use a temporary memory cache during a session, select Project> Cache from the Build menu.
• The HMI cache files are in .ura format. To create a .ura file containing static displays, select Export Displays to

Select this to save static HMI Displays, improving VisiLogic Remote Access times.

Select this to create a .ura file containing static HMI Displays; this file may be imported into the Remote Access utility.
Color Vision only

The static HMI files are in .urc format. Such files can be created in Remote Access by selecting the option Create Fonts and Images (*.urc) from PLC shown in the following figure. The .urc file may include either fonts, images, or both. However, note that if the .urc file does not include graphics, Remote Access will not display images.

![Create Fonts and Images](image)

**Note**

When Remote Access creates a .urc file, the Vision enters 'System Mode'; the PLC continues running while displaying a system image. The HMI application is not visible.

In addition, note that an interruption in communications may leave the PLC inaccessible. In this case, the PLC may require reset, which requires an operator to be **physically** present near the PLC.
Utilities

Utilities: an Overview

Vision controllers offer a broad range of utilities.

Some utilities are internal to VisiLogic, some are provided by external software tools that may be freely downloaded from the Unitronics website.

This section describes general functionality. For complete information, refer to the manual VisiLogic Utilities.

VisiLogic Utilities

SD Cards

Enhanced Vision controllers support SD cards. The V570 supports standard-sized SD cards; V130, V350 and V1070 support micro SD cards. In the V570 series, the slot is located at the top of the controller; in V130, V350 and V1070 the slot is located on the right side.

What can I do with an SD card?

- "Clone" a complete PLC, via Information mode or via SD Clone Ladder elements.
- SD Ladder Functions enable you to read/write data between an SD Card and PLC memory operands, including blocks of file data, Data Tables, and Trend data.
- Store Alarms History on SD.
- Use Information Mode or SD Clone Ladder elements to upload/download OS firmware and compressed VisiLogic Applications, Data Tables, and operand values to/from an SD card, and to backup and even completely 'clone' a PLC.
- Use Unitronics' SD Card Explorer, included in the SD Card Suite, to transfer SD files from PLC to PC--or, if the PLC comprises an Ethernet card, send files via email attachment.
- View and execute files on the PLC display via the HMI element SD Browser.
- Use the tools in SD Card Suite to:
  - Format the SD Card.
  - Convert, view, and read/write the data to/from PC.
  - Export that data to Excel or as an .csv file.
  - Remotely view, open, copy, or delete SD card files via serial, CANbus, or Ethernet.

This standalone software is available from:
Data Tables

You can store data into the Data Table memory section of your controller, then access the data in accordance with program requirements. They are useful in implementing Program Recipes, a collection of ingredients or values that are used to prepare a batch of product or to perform a specific task.

Data Tables can be used to contain parameters for pre-programmed recipes. Vision controllers can contain up to 120K of Data Tables (RAM); Data Tables (that are marked Part of Project) can take up to 192K (Flash) in V230/260/280/290.

You create tables in VisiLogic, define their structure, then download them to the controller. Data within the tables can be copied and pasted to and from third-party tools such as Excel.

You can also store Data Tables or log lines from them onto SD Cards.

Note

- Data Tables are based on bytes, not on registers.
- Data Table sections that are marked Part of Project: the data are downloaded with the project, and burned into the Flash memory. You can use this feature to preserve certain, unchanging data, such as lists of names or recipe data.
- A Data Table marked as Part of Project cannot be copied to an SD card.

Data tables consist of columns and rows.
String Library

Use String Library to store text strings within the controller’s FLASH memory, and then display them on the controller’s LCD. You can, for example, organize text into different String Libraries—for example, separate libraries for Spanish, English and Italian—pull strings into HMI objects, and then switch libraries to change the display language.

These strings can be displayed in the following HMI elements:

- Frame
- Button
- Fixed Text

String Libraries also provide the text for Alarms, and can be used in Trend Curve Properties.

There are:

- 16 String Libraries containing up to 1024 strings each. You can change the library default names.
- Via String Library> File, you can opt to use only 4 or 8 libraries; in this case the total number per library is 2,046 strings.
- Note that each library contains sections in the 3,000 range, that are ‘greyed’; these are reserved for system use.
- Each string can contain up to 128 characters.

The **total memory capacity** for all String Libraries is 64K.

ℹ️ | This feature is not available in Standard Vision controllers.

**How String Library works**

Only one library is active at a time. This means that at any given time, all elements that pull text from a library are using the **same** library.

However, each HMI element may be linked to a **different** line ID # within that String Library.

In the following figure, the buttons are linked to different text lines. Each time a different String Library is called, the button text changes.
Alarms

An Alarm is an event that is reported to the machine operator via a set of built-in displays. The event is a change in the Alarm’s Trigger condition, which may be linked to either a Boolean or a numeric value. An Alarm can:
- Show Alarm status
- Report the event to the machine operator
- Provide instructions
- Require operator action
- Play an active role in the conditions enabling the running of the process

In VisiLogic, you use the Alarm Configuration utility to create Alarms and set their features. The Ladder application determines when the Alarms are displayed on the controller’s screen.

Vision controllers support Alarms according to the following table:

<table>
<thead>
<tr>
<th>Vision Type</th>
<th>Number of Alarms</th>
<th>Number of Alarms in History</th>
</tr>
</thead>
<tbody>
<tr>
<td>V570</td>
<td>128</td>
<td>254</td>
</tr>
<tr>
<td>V350</td>
<td>64</td>
<td>62</td>
</tr>
<tr>
<td>V130</td>
<td>16</td>
<td>14</td>
</tr>
</tbody>
</table>

Alarms may be divided into up to 16 groups, per application.

While the Alarms displays are on the screen, the PLC application continues to run. This includes both the Ladder, including subroutines, and the HMI application. This means that the current HMI display, the one on the screen when the PLC enters Alarms, may not be the same one displayed when the PLC exits Alarms.
Note • This feature is not available in Standard Vision controllers.

Web Server
Enhanced Vision controllers can host web pages. The controller must comprise a TCP/IP port, and must be connected to an Ethernet network. If the controller contains web pages, a remote user can enter the IP address of the controller into a web browser and view the pages.

You can also host complex Web pages using the program in the .zip file located at: http://www.unitronics.com/data/uploads/communication/WebServer.zip

Unitronics’ Software Utilities
These utilities can be freely downloaded from http://unitronics.co.il/Content.aspx?page=Downloads.

Remote Operator
Remote Operator enables you to use a PC to view and work with a remote controller’s HMI panel.

You can define any number of controllers, then open multiple sessions to view them simultaneously, while docking or cascading windows according to your preferences.

During a session, the remote controller is displayed, on-line, on your PC screen. You can ‘press’ keypad keys and touch-screen objects of:

- Stand-alone controllers that are directly connected to the PC via a cable.
- Controllers within a network.
- Devices with IP addresses, via Ethernet.

This utility can be used with Vision, M90/91, and Jazz controllers.

Remote Access: Stand alone Utility:
The stand-alone utility Remote Access runs independently of all other software, and can access Vision, M90/91, and Jazz controllers. In addition to using any supported communication channel to remotely access the controller and its HMI display, the Remote Access package includes additional utilities:

- UniDownloader Designer
- Operand Access
- Data Tables

SD Suite
The SD Card Suite contains several applications that you need to work with SD cards:

- Tools
  Includes the Card Formatter (note that a card must be formatted before use), the HTML Compiler for webpages served from the SD, and the Fill Time Calculator which enables you to determine how long your application will take to fill up the SD Card.
Utilities: an Overview

- **SD Card Explorer**
  Use a PC to access, read and write files on an SD Card that is installed in a Vision controller

- **SD Card Manager**
  Import SD files: Trends, Logs, Alarms, and Data Tables, view them, and export them to Excel or .csv files.

- **Data Tables Editor**
  View, export, and edit Data Table files.

**DataXport**
DataXport creates logs of run-time or stored data from Data Tables and operand regions within Unitronics PLCs. DataXport saves the data logs in .ulp format. You can open these data logs using DataXport's companion application, DataXls, and then export the data to Excel files.

Via DataXport, you can:
- Log data according to a date/time-based schedule.
- Simultaneously log data from one or more Unitronics PLCs.
- Access PLCs and log data via a direct, network, or modem connection.

**UniOPC Server**
UniOPC Server (Unitronics OPC Server) enables you to read and write data between Unitronics PLCs and applications that support OPC, such as SCADA programs. UniOPC Server is compliant with the OPC Foundation's Data Access Custom Interface Standards through to Version 3.00.

UniOPC Server runs independently of other Unitronics software.

**UniDDE**
UniDDE (Unitronics Dynamic Data Exchange) enables you to read and write data between Unitronics PLCs and applications that support DDE, such as Excel. Although it is installed as part of the VisiLogic Setup, UniDDE runs independently of other Unitronics software.

**UniVision Licensing**
You can create a PLC license number and burn it into a secured, hidden sector in the PLC.

You can then use this license in your Ladder to control how your program functions.
Creating Project files (.dvi, .vdf, .urc, .ura)

Project files contain application data in compressed format. There are several kinds of files.

- **Clone Files:**
  These can contain complete applications in compressed format, including Ladder and HMI applications and OS. Clone files are very convenient for OEMs, or for those wanting to 'Clone' a PLC and its application. These files can be created in VisiLogic as well as via SD Clone Ladder functions or in Information mode.

- **Project Files: UniDownloader Designer**
  These files include both the Ladder and HMI applications, Data Tables, and an Upload file.
  - Standard Vision: .dvi files
  - Enhanced Vision: .vdf
  Note that the DownLoader files you create here are compatible with UniDownloader 4.0.0 and later; provide your users with the correct UniDownloader version.

- **Cache files: Remote Access and Remote Operator**
  These are compressed HMI Displays. They improve Remote Access reaction times, and must be used to display graphic images when using Remote Operator.
  - Monochrome Vision (.ura files)
    A .ura cache file enables Remote Operator to load Displays more quickly. Note that V130, which loads displays quickly, does not use .ura files.)
  - Color Vision (.urc files).
    If a .urc is not used, images are not displayed and fonts may be distorted.
    A cache file includes fonts, and can include images.
    If the file does not include images, a red 'X' displays in place of graphics.

To create Project files:

1. Click on the Project menu and select Create Project files.
2. Select the appropriate tab and follow the on-screen directions.
Notes

.cxx Files

- PLC Unique ID
  Each PLC has a unique ID number, which is shown in SDW9.
  Use this number to restrict a program to a particular PLC.

- Password:
  This is assigned to the SD Card via the Set SD Card Password function.

- Both the controller you use to make the download file (source), and the controller that is installed with the file (target) should be installed with the same OS Version.

- To avoid errors in the file, the creation process must run smoothly, without being aborted or affected by PC faults.

Checking the integrity of the .dvi file

Although you do not need to have Remote Access installed on your PC in order to create .dvi files, you need to install it in order to check .dvi files.

1. After you have created the .dvi file, save the project from which it was downloaded.
2. Open a new, empty project and download it to the controller.
3. Start Remote Access and select the appropriate Vision model.
4. Click on the Project Downloader which is located on the Remote Access Tools menu.
5. Navigate to the .dvi file and download it into the controller.
6. Reopen the original Ladder project used to create the .dvi file.
7. Select Verify from the Controller menu; the Verify process will compare the project in your PC with the .dvi application installed in the controller.

If the Verify process is successful, the .dvi file is valid.

**UniDownloader Designer**

The UniDownloader package enables you to build a complete, compressed project and send it anywhere to be installed in a PLC using a standalone downloader. Your end user will be able to download the application, but will not be able to view or modify it. The tool can download applications and OS.


To learn about UniDownloader, click on the Tools menu in VisiLogic, U90 Ladder, or Remote Access, select UniDownloader Designer, and then access the UniDownloader Designer Help.

---

**Project Properties**

This is located on the Project menu. Click on the tabs to view and edit the various properties.

- General (includes Project Password)
Password security restriction: if a PLC operator enters a wrong password 9 times, the PLC **automatically disables program upload** for that program.

Resetting the PLC will enable you to try another 9 times.

The limit set on password entry is intended to provide an additional layer of security. For example, this can prevent a hacking script from entering a networked PLC, since the number of attempts is limited and such a script would not reset the PLC.

- **Download**
## Project Properties

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable Project upload</td>
<td>If you select this, no user will be able to upload the project from the PLC, even with a password.</td>
</tr>
<tr>
<td>Rebuild, then Download</td>
<td>Select this if the project was originally created in another VisiLogic version.</td>
</tr>
<tr>
<td>Warn about Vision 120 Snap-in conflicts</td>
<td>This option is checked by default, causing, VisiLogic to issue a compilation warning message if the Vision120 selected in Hardware Configuration is different from the one to which you are downloading. Uncheck this option to disable such warnings.</td>
</tr>
<tr>
<td>Compiled Ladder Allocation</td>
<td>If your application requires, you can select this option and enter a different amount.</td>
</tr>
</tbody>
</table>
| Back up and Restore PLC RAM Data | Backup a project together with all of the current values in Data Tables and all memory operand values. If this option is selected:  
  - At project upload, the PC will upload all of the current values in Data Tables and all operands--except for system operands. To back up system operand values, store them to memory operands.  
  - At project download, the PC will download the complete project, including all of the current values in Data Tables and all memory operands.  
  Note that this option is not part of the project. It affects all the projects downloaded from the PC. |
| Save Unit ID in Project          | When you select the Save Unit ID option, the ID number of the controller selected in Connection>Communication & OS>Vision-PC Communication Settings is saved together with the project. You will not be able to download the project to another controller until the number is changed. |
| Display OnLine Tools             | Keeps the Test Tool bar from being displayed during Test Mode |
| Check Digital Signature          | Select this to check the digital signature of the project in a PLC every time PC-PLC connection is established. |
## Ladder

![Properties Window]

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto-extend</td>
<td>Adds 5 grid points to each net, following the bottom edge of the lowest Ladder element.</td>
</tr>
<tr>
<td>Mouse wheel, Scroll Bar Resolution</td>
<td>Customizes resolution of Page Up / Page Down.</td>
</tr>
<tr>
<td>Auto Horizontal, Auto Vertical Placing</td>
<td>Defines the number of grid points that activate auto-snap. Auto-snap causes an element that is placed in the Ladder to snap to the output of the previous element in the rung.</td>
</tr>
<tr>
<td>Hot keys</td>
<td>Link frequently used functions to short-cut keys.</td>
</tr>
</tbody>
</table>
Digital Signatures

View Digital Signatures by clicking the View menu and selecting Show Signature Log. This project security feature can enable Vision PLCs to meet standards in niche industries such as pharmaceuticals. The log:

- Records changes made in a project.

Color

You can assign any color to show power flow during Test mode.
- Tracks the last projects downloaded to a PLC.

![Signature log view](image)

- Enables you to save the signature log within a VisiLogic project.

![Signature log view](image)

- Compares the signature of the project to the signature of the last project that was downloaded to the PLC.

![Signature log view](image)

**Operand View**

Use the Operands tab in the Output Window to see if operands and I/Os are used in a program, assign power-up and preset values, view current values when you run Test mode, change formats, assign descriptions (symbols), and view and edit Watch Folders. You can also view Project Optimizer results.

![Operand View](image)
**Hotkeys: Quick Editing**

VisiLogic offers keyboard shortcuts for a number of tasks, including Ladder editing. You can also assign certain tasks to keys F3 and F4 via Program Properties.

*Note* • Selected Ladder elements can be moved within a net via the keyboard arrows.

<table>
<thead>
<tr>
<th>Task</th>
<th>Hotkeys</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ladder</strong></td>
<td></td>
</tr>
<tr>
<td>Pressing the appropriate key attaches the element to the cursor; click to drop it into the net.</td>
<td></td>
</tr>
<tr>
<td>Once a Ladder element is placed in the net, the user can typed the operand name and number, for example SB41, and then press Enter.</td>
<td></td>
</tr>
<tr>
<td><strong>Note</strong> • Selecting an element and pressing &lt; Fn&gt; attaches the new element to the one selected.</td>
<td></td>
</tr>
<tr>
<td><strong>Within Operand Address Box</strong></td>
<td></td>
</tr>
<tr>
<td>Get Next Address</td>
<td>&lt;Ctrl&gt; + &lt;N&gt;</td>
</tr>
<tr>
<td>Symbolic Search</td>
<td>&lt;Ctrl&gt; + &lt;L&gt;</td>
</tr>
<tr>
<td>Toggle to Hex (when entering Constant value)</td>
<td>&lt;Ctrl&gt; + &lt;H&gt;</td>
</tr>
<tr>
<td><strong>Go to Label</strong></td>
<td></td>
</tr>
<tr>
<td>This enables to you skip from label to label. Note that labels can be used both as bookmarks as well as to cause program jumps.</td>
<td></td>
</tr>
<tr>
<td>Next Label</td>
<td>&lt;Alt&gt; + &lt;Right Arrow&gt;</td>
</tr>
<tr>
<td>Previous Label</td>
<td>&lt;Alt&gt; + &lt;Left Arrow&gt;</td>
</tr>
<tr>
<td><strong>Open Label Navigation</strong></td>
<td>&lt;Alt&gt; + &lt;L&gt;</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td></td>
</tr>
<tr>
<td>Open Help</td>
<td>&lt;F1&gt;</td>
</tr>
<tr>
<td><strong>Project</strong></td>
<td></td>
</tr>
<tr>
<td>New Project</td>
<td>&lt;Ctrl&gt; + &lt;N&gt;</td>
</tr>
<tr>
<td>Open Project</td>
<td>&lt;Ctrl&gt; + &lt;O&gt;</td>
</tr>
<tr>
<td><strong>Print Project</strong></td>
<td>&lt;Ctrl&gt; + &lt;P&gt;</td>
</tr>
<tr>
<td><strong>Exit Project</strong></td>
<td>&lt;Alt&gt; + &lt;Q&gt;</td>
</tr>
<tr>
<td><strong>Edit</strong></td>
<td></td>
</tr>
<tr>
<td>Select All</td>
<td>&lt;Ctrl&gt; + &lt;A&gt;</td>
</tr>
<tr>
<td><strong>View Toggles</strong></td>
<td></td>
</tr>
<tr>
<td>Find</td>
<td>&lt;Ctrl&gt; + &lt;F&gt;</td>
</tr>
<tr>
<td>Show/Hide Project Explorer</td>
<td>&lt;Ctrl&gt; + &lt;R&gt;</td>
</tr>
<tr>
<td>Show/Hide Ladder</td>
<td>&lt;Ctrl&gt; + &lt;Alt&gt; + &lt;L&gt;</td>
</tr>
<tr>
<td>Show/Hide HMI Display Editor</td>
<td>&lt;Ctrl&gt; + &lt;Alt&gt; + &lt;H&gt;</td>
</tr>
<tr>
<td>Show/Hide Output Window</td>
<td>&lt;Ctrl&gt; + &lt;W&gt;</td>
</tr>
<tr>
<td>Show/Hide Comments</td>
<td>&lt;Alt&gt; + &lt;C&gt;</td>
</tr>
</tbody>
</table>
Watch Folders

Watch Folders enable you to:

- Arrange related groups of operands in folders.
- Name the folders.
- View these operands in the tabbed Output Window at the bottom of the screen.
- If you are connected to a PLC, you can enter On-line Test Mode to see real-time operand values.

To view a Watch folder, click the Watches tab at the bottom of the screen, then select the desired folder. Edit the folder by right-clicking a line, then selecting the appropriate function.

Adding Operands to a Watch Folder from a net

- To add a single operand to a Watch folder, right-click it in the Ladder or in the Operand Output Window.
Memory enables you to view a vector according to the length you set and in ASCII, HEX, Binary, or Decimal format.

1. Click on the 'Memory' tab in the Output Window at the bottom of the VisiLogic screen.
2. Right-click in the window to add rows.
3. Click in the Operand column to link operands.
4. Click in the Length column to assign a vector.
5. Click in the Size column to select 8, 16, 32 bits.
6. Click in the Format column to select ASCII, Binary, Hex, Decimal.
7. Enter Online Test Mode.

When ASCII is the selected format, you can click a line and force a string to the vector. Note that to force the value, you must click the 'eyeglass' symbol in the On-line window.

Find (& Replace)

Highlight an operand or Ladder Element and press <Ctrl> + <F>; the results will be displayed in the Output window at the bottom of the screen. Highlighting a function and pressing <Ctrl> + <F> will open a dialog box, enabling you to select the desired operand.

In addition, right-clicking most program elements will display the Find button. In addition, VisiLogic offers the following Find functions:

- Find
  - Use Find to locate operands, labels, subroutines and Displays.
You can also right-click an element or subroutine to display the Find icon on the right-click menu.

**Notes**

Labels: Clicking on a found 'Label' will list the Jump to Label linked to that label in the Output Window.

- **Find Element**
  The Find Element utility enables you quickly locate any element that is used in a project.
  
  1. Select Find Element from the Edit menu; the utility opens.
  2. Click the desired element type in the left pane, then select the element from the right and click OK.

You can select more than one element by holding the CTRL key down and clicking the desired elements.

- **Find & Replace Operand**
  The Find & Replace Operand utility enables you quickly replace any operand or vector of operands that is used in a project.

  1. Select Replace Operand from the Edit menu; the Replace utility opens.
  2. The Select Operand box opens; select the Source and Target operands.
  3. To restrict the Replace operation to a specific subroutine, click the Subroutine field to open the selection box, then click the desired subroutine.
  4. To replace a vector, enter its length.
  5. To copy the operand descriptions, power-up values, and formats, select Copy Properties; select Clear Source to remove these from the source operands.
  6. Click OK; the operands are replaced.

In the following figure, running the Replace function replace all instances of MB 100 in the Subroutine Fault Message with the operand I 10.
Find FB
Find FB enables you to locate the FBs in your project.

1. Select FB information from the View menu; Function Blocks Information opens.

2. Select the FB and operation you want to find.

3. Click the Find icon, the Output window displays the results.

4. Close the Function Blocks Information box, then double-click on a line in the Output window; the project opens at the found location.

Find Font
This enables you to find fonts used in HMI Displays.
1. Click to open the Font Handler
2. Select the desired font, then click Find; the results are displayed in the Output window.
3. Close Font Handler, then double-click on a line in the Output window; the project opens at the found location.

Finding a Load Display Target

Right-click the element to open the menu.

This causes the Find utility to search for the Call function’s target.

This opens the Call function’s target.

VisiLogic: Getting Started
Finding a Call Subroutine Target

Right-click the element to open the menu.

The command the Find utility to search for the Call function’s target.

The opens the Call function’s target.

Go To Label
To find Labels, use Go To Label <Alt> + <Right/Left arrow> and List of Labels <Ctrl> + <L> utility.

Find Constant Value
To find Constant values, either:

- Click on the Constant, then press <Ctrl> + <F>; the results appear in the Output window.
Start Find, select the Constant tab and enter the value, then press OK; the results appear in the Output window.

Search: Symbolic Name
Use Search: Symbolic Name to find operands by description. Within the Select Operand box, this is activated via \(<Ctrl>+<L>\).
Deleted Unreferenced Operands
To help manage your project, you can delete unreferenced operands.

Print Project
Print Project is located on the Project menu.
Via the Print dialog box, you can print various aspects of your project. Print Preview is also offered.
System Images

You can customize your application by replacing system images, such as the Unitronics' Splash Screen, and the Unitronics' icon that appears in Information mode, with your own custom images.

1. On the Project menu, click System images.
2. Click on the desired image, click on Replace Image, and navigate to your custom image.
Notes

- You can restore default System Images by clicking on the appropriate button
- You can replace the virtual keypad images; however note that the touch locations for the keys will not be changed from the default.

Converting Projects

If you open a project based on a Vision with a monochrome LCD screen, VisiLogic provides the following utilities on the Project menu:

- Convert to V130
  Use to convert a project based on the V120 to V130.
- Monochrome to Color
  Use to any project based on a monochrome LCD to color, such as V290 to V570.

Import/Export Subroutines

You can export Subroutines and save them as .vlx files, then import them into other projects. You can import/export single Subroutines, or all of the subroutines in a Module. Note that you cannot export Subroutines from the Main Module.

Exporting a single Subroutine

1. Right-click the desired Subroutine and select Export Subroutine, -or-
   select Export Subroutine from the Project menu; the Select Subroutine box opens.
2. Select the desired subroutine, then save it to the desired folder.
Exporting all of the Subroutines in a Module

1. Right-click the desired module and select Export All Subroutines.

2. Save the .vlx file to the desired folder.
   
   Note that when you import this .vlx file, all of the Subroutines it contains will be imported.

Import

1. Right-click a module name and select Import Subroutine,
   - or-
   Select Import Subroutine from the Project menu; the Open box appears.

2. Select the desired subroutine, then save it to the desired folder.
Import/Export is subject to the limitations below.

- If the source project contains Call Subroutine or Load HMI operations, note that the referenced elements will be marked as **missing**, even if the target project contains elements of the same name. Note that you can reassign the references.

- If the selection contains an FB operation related to an FB Configuration, and is imported into an application containing an FB Configuration of the same name, the links will be retained.
  If, for example, you export a subroutine containing an SMS Send FB linked to SMS Configuration 'Denmark' and then import this subroutine into another application containing an SMS Configuration 'Denmark', the SMS Send FB will automatically link to 'Denmark'.

- If the selection contains FBs, and no FBs of that type currently exist in the target project, the pasted FBs will be the version currently in VisiLogic FB library—in other words, if the source selection contains older FB versions, they are automatically updated during the Paste operation.

- If the selection contains FBs, and FBs of that type currently exist in the target project in a **different** version, Paste cannot be completed.

- If your selection contains only Jumps, without the attendant Labels, they will be marked as **missing**, even if the target project contains Labels of the same name. Note that you can reassign the references.

- If the selection contains Jumps and Labels with the same name as those in the target project, the Jump, Label and link between them will be automatically recreated by VisiLogic when they are pasted.
In this way, VisiLogic maintains the integrity of the links between Jumps and their corresponding Labels.

Note that the following symbols cannot be used in subroutine names: `/ 
| * : ! " < >`. In addition, please note that a name may not include a period followed by a space (for example `My. Subroutine`). When importing/exporting from older VisiLogic programs containing such symbols, they will be automatically replaced by underscore characters.

**Verify Project**

The Verify utility shows the differences between the project open in your PC and the program currently installed in the controller.

To use Verify:

1. Connect your PC it to the controller using a program download cable
2. Select Verify from the Connection menu.

Verify marks different sections with an ✗, as shown below.
Compile
To test your project, compile it.
1. Select Compile from the Build menu.
2. After compiling the project, VisiLogic displays errors in the Output Window.

Clicking the Compile tab displays the last compiled results.

Compilation Error Message #37

Message # 37 is displayed when a V120-12-xx is selected in the project's Hardware Configuration, and the project contains a function that is not supported by that model.

Project Optimizer
Run the Optimizer to view a list possible improvements that you can make in your project. In the results window, double click a line to jump to the appropriate location in the project.
Log
To view a log of events, click the Log tab at the bottom of the Output Window.

Show STL
You can view STL code for a particular Subroutine, whether off-line or in Online Test mode.

To view STL online test values after downloading a project to a controller, open STL View, then press F9 to enter online test mode.

Power-up Modes: Trouble-shooting
You can force the controller to boot up into Bootstrap (OS, BIOS) or Stop mode (hard reset) by turning on the power supply while pressing specific keypad keys.
## Power-up Modes: Trouble-shooting Tools

### EX-RC1

- **V120/130**
- **V230/260**
- **V280**
- **V350/290/530/570/V1040 (touchscreen)**

#### Bootstrap

- The controller's LCD is on.
- PC-PLC communications are enabled, but PC must be in Bootstrap, but no OS.

**Possible Actions**

- Via Vision Communication
  - PC Settings, you can:
    - Check which OS is currently installed in the controller.

- Move all DIP switches to 1
  - <I> + <ESC> + <Right Arrow>

- Turn the PLC off.
- Enter Bootstrap mode by touching the screen and maintaining contact while turning the power on.

**Bootstrap version**

*V2.00 and up*

- If no action is taken, the PLC enters Run mode after several seconds. If no action is taken, the PLC enters Run mode.

**Note**

- Bootstrap version 7.00 or earlier, startup message is "V7.00"

**Possible Actions**

- Move all DIP switches to 1
  - <I> + <ESC> + <+/->

- Turn the PLC off.
- Enter Bootstrap mode by touching the screen and maintaining contact while touching the screen.

**Restriction**

- *Visions embedded in the controller*
Memory Allocation

You can check the flash memory requirements of a project via Projected Memory Allocation, which is located on the Build menu.

You can also view the current allocated flash memory of a controller via PLC Flash Memory Allocation, which is located on the Connection menu.

**Note** Vision uses dynamic memory allocation.
Ladder Code Capacity

The table below shows how much memory is allocated for the Ladder code; note that an additional sector comprising double that amount is allocated for compiled Ladder code.

<table>
<thead>
<tr>
<th>Controller Model</th>
<th>Ladder Code</th>
<th>Compiled Ladder Code</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>V230, V260, V280</td>
<td>64K</td>
<td>128K</td>
<td>320K</td>
</tr>
<tr>
<td>V120</td>
<td>32K</td>
<td>64K</td>
<td>192K</td>
</tr>
</tbody>
</table>

During download, Ladder code is compiled into machine code. The compiled code may exceed the memory that is allocated for compiled Ladder code. If the allocated memory is exceeded, the message below will appear at download.

Note: If the second download attempt is not successful, the message will be displayed again. If this occurs, contact technical support.
Appendix A: Troubleshooting

Detecting Short-circuited End Devices

The controller can detect short circuits in end devices (loads) that are connected to transistor outputs located on snap-in or expansion I/O modules.

If a short circuit is detected on either an expansion or snap-in I/O module, SB 5 turns ON.

If the short circuit is located on:
- I/O expansion module, the location is indicated in SDW 5.
- Snap-in I/O module, the LSB in SDW 6 turns ON.

SDW 5 provides a bitmap. Each I/O expansion module included in your controller's hardware configuration is assigned a number, 0-7, according to its place in that configuration. In the bitmap, bits 0-7 correspond to these place numbers.

In the bitmap below, short circuits have been detected in devices that are connected to expansion modules 1 and 3.

SDW 5

Please note that although an SW is 32 bits long, only 16 bits are shown below.

<table>
<thead>
<tr>
<th>Bit#</th>
<th>15</th>
<th>14</th>
<th>13</th>
<th>12</th>
<th>11</th>
<th>10</th>
<th>9</th>
<th>8</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output location</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
</tbody>
</table>

Positive Transition Contact ( Rise )

A Positive Transition Contact gives a single one-shot pulse when the bit operand it is linked to rises from OFF (logic 0) to ON (logic 1). A Negative Transition Contact gives a single one-shot pulse when the bit operand it is linked to falls from ON (logic 1) to OFF (logic 0). You can link them to any of the following bit operands:
- Memory Bit
- System Bit
- Output
- Timer
- Counter

A cellular phone keypad key is an example of a Positive Transition Contact. When you push a key a number is displayed on the screen. It does not matter if you push the key quickly or hold it down for several seconds. The number will only appear once on the screen.

The cellular phone registers the transition from key NOT pressed to key pressed. The length of time the key is pressed is not relevant. You must release the key and press it again to repeat the number on the cellular phone screen.

During the system scan, a Positive Transition Contact address is evaluated for a transition from OFF to ON. A transition allows power to flow through the Positive Transition Contact for one scan.
At the end of a scan, the Positive Transition Contact is reset to ON (logic 1). The Positive Transition Contact is re-activated when the linked signal turns from OFF to ON.

**Note**

Execution time for Positive and Negative Transition contacts is considerably greater than the execution time for direct and indirect contacts. However, you can decrease the amount of transitional contacts in your program.

### Decreasing the Number of Transitional Contacts

You can use the coil of a bit operand to save the positive transition of a contact, and then use the direct contact of the operand in your program.

You can use the Direct Contact of SB 13 instead of using the Positive Transition Contact of SB 3, and the Direct Contact of SB 15 instead of using the Positive Transition Contact of SB 7.

SB 3 is a pulse generator, with a cycle time of 1 second and a duty cycle of 50% (0.5 seconds ON, 0.5 seconds OFF).

SB 13 is the Positive Transition (rising edge) contact of SB 3.

SB 7 is a also a pulse generator, with a cycle time of 0.1 second.

SB 15 is the Positive Transition (rising edge) contact of SB 7.

### Rise/Fall Usage Summary

The maximum number of Rise/Fall elements that is allowed in a project depends on the controller model. To ascertain how many elements of each type are in the project, use the Rise/Fall utility on the View menu.

The sum of the results must not exceed:

- V570 – 1024 (0...1023)
If a program exceeds this number, Error 1017 results. However, in certain cases, the actual compiled number of Rise/Fall elements is greater than the total that is shown in the Summary. Examples are shown below.

Example 1

![Example 1 Diagram]

Example 2

![Example 2 Diagram]
Appendix A: Troubleshooting

VisiLogic: Getting Started

Positive Transition Contact (Rise)

Here, the net above is split into 2 nets.

Net 2

```
<table>
<thead>
<tr>
<th></th>
<th>MB</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>MB</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>LB</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>LD</td>
<td>0</td>
</tr>
<tr>
<td>&amp;R</td>
<td>MB</td>
<td>0</td>
</tr>
<tr>
<td>%</td>
<td>MB</td>
<td>6</td>
</tr>
<tr>
<td>%</td>
<td>MB</td>
<td>3</td>
</tr>
<tr>
<td>%</td>
<td>MB</td>
<td>5</td>
</tr>
<tr>
<td>%</td>
<td>MB</td>
<td>7</td>
</tr>
</tbody>
</table>
```

Net 3

```
<table>
<thead>
<tr>
<th></th>
<th>MB</th>
<th>4</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>MB</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>LB</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>LB</td>
<td>0</td>
</tr>
<tr>
<td>&amp;R</td>
<td>MB</td>
<td>0</td>
</tr>
<tr>
<td>%</td>
<td>MB</td>
<td>1</td>
</tr>
<tr>
<td>%</td>
<td>MB</td>
<td>1</td>
</tr>
<tr>
<td>%</td>
<td>MB</td>
<td>10</td>
</tr>
</tbody>
</table>
```
I/O Expansion Module Errors

An interruption in communication between an I/O expansion module and controller can cause the controller to enter Stop Mode, and an ‘Expansion Error’ message to be displayed on the controller’s LCD.

This error results when:

1. The module was connected at power-up.
2. The communication between module and controller was interrupted for more than 200 milliseconds. Interruptions may occur if the connecting cables are disconnected, or may result from signal interference (noise).

Note: When a controller enters stop mode, the program stops running and all outputs within the system are initialized. This includes on-board outputs, outputs located on Snap-in I/O modules, and outputs located I/O expansion modules.

What to do

- Check that the cables are connected and in proper order.
- Remedy signal interference. Such an error may also result from a hardware malfunction.
- If the RUN LED on the expansion module blinks, check the documentation supplied with the expansion module to see if a hardware error is indicated.
- To exit Stop Mode, reset the controller either by turning it off and on, or by entering Information Mode, and then selecting System>Working Mode> Reset.

Analog Input Values: Out of Range

Expansion modules

If an expansion module’s analog input is receiving current or voltage in excess of the absolute maximum rating, the corresponding Out Of Range indicator lights up.

**IO-AI4-AO2**

Analog value: from 0 to 4095 (12 bit). If the analog input is:

- below 0V/0mA, then the analog value will be 0.
- above 10V/20mA (about 2% above the full scale), then the analog value will be 4096.

**IO-ATC8**

Analog value: from 0 to 16383 (14 bit). If the analog input is:

- slightly below 0V/0mA (about 0.5% below 0V/0mA), then the analog value will be -1.
- slightly above 10V/20mA (about 0.5% above the full scale), then the analog value will be 16384.
- If the analog input is greatly below or above of the analog input range, but still within the range of the absolute maximum rating, then the analog value will be 32767.
Vision models

**V120-12-R1, V120-12-R2C, V200-18-E1, V200-18-E1B and V200-18-E2B**

Analog value: from 0 to 1023 (10 bit). If the analog input is:
- Below 0V/0mA, then the analog value will be 0.
- Above 10V/20mA (about 2% above the full scale), then the analog value will be 1024.

**V120-12-UN2, V120-12-UA2**

Analog value: from 0 to 16383 (14 bit). If the analog input is:
- Slightly below 0V/0mA (about 0.5% below 0V/0mA), then the analog value will be -1.
- Slightly above 10V/20mA (about 0.5% above the full scale), then the analog value will be 16384.
- Greatly below or above of the analog input range, but still in the range of the absolute maximum rating, then the analog value will be 32767.

Note that the absolute maximum rating of the analog inputs for all the units is +/- 15V.

**Compile**

To test your project, compile it.

1. Select Compile from the Build menu.
2. After compiling the project, VisiLogic displays errors in the Output Window.

   ![Compile Tab](image)

   Clicking the Compile tab displays the last compiled results.

**Compilation Error Message #37**

Message # 37 is displayed when a V120-12-xx is selected in the project's Hardware Configuration, and the project contains a function that is not supported by that model.
### Compatibility: HW, OS, SW

Both the OS that runs the PLC and your current software version must support the hardware, such as I/O Expansion Modules, that you use in your applications.

Note that there is a list of OS changes in the Downloads Section of the Unitronics web site:


<table>
<thead>
<tr>
<th>Hardware</th>
<th>Supported by OS Version</th>
<th>Supported by VisiLogic Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>V200-18-E4XB</td>
<td>4.00 Build 25</td>
<td>4.06</td>
</tr>
<tr>
<td>V120-2-R34</td>
<td>V4.50 B06</td>
<td>4.54</td>
</tr>
</tbody>
</table>

#### V120-12-xxx Unsupported Features

These are older V120 models which cannot support certain recent features. These features are supported by the V120-22-xxx series.

- **V120-12-xxx** is no longer supported, in released version VisiLogic 4.7.4, OS 470 (06), and later.

<table>
<thead>
<tr>
<th>Unsupported Feature</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>FBs</td>
<td>Trends</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Draw Axis</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Accelerate</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Remote PLC DataCom</td>
<td></td>
</tr>
<tr>
<td></td>
<td>GPRS</td>
<td></td>
</tr>
<tr>
<td></td>
<td>BAS</td>
<td></td>
</tr>
<tr>
<td>FB features</td>
<td>Protocol:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>floating values</td>
<td></td>
</tr>
<tr>
<td></td>
<td>MODBUS:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Read/write mixed data commands, Read/write tables</td>
<td></td>
</tr>
<tr>
<td>Communications</td>
<td>UNICAN DataCom</td>
<td></td>
</tr>
<tr>
<td>Ladder Functions</td>
<td>Data Tables:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Find Row Extended, Read/write Column, Copy Row and Copy column, Clear Row and Clear Column</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vector:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Struct, Swap bytes, Sort, Copy memory (MF)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Math:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Formula</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vector:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Linearization</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Store:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>BCD to Num, Num to BCD</td>
<td></td>
</tr>
</tbody>
</table>

110 VisiLogic: Getting Started
Strings:
- Mac address to ASCII, Time to ASCII, ASCII to Num,
- Logic, RLO to Bit, Set/Reset Bit (SI, SL, SDW)

More:
- Immediate: Write to Physical Analog Output, Debug: Interval

HMI
- Previous Variable, Clear rectangle

HMI Features
- Clock variable-UTC
- Enter ASCII String via Keypad
- Shape Graphs
- Draw Static Axis
- Moving image

General features
- Interrupt:
  - High speed counter, Interrupt 2.5mSec

COM Port 2
- Does not support a baud rate of 115200 bps

SBs
- SB13, ON at Rising Edge of SB3 (1sec pulse)
- SB15, ON at Rising Edge of SB7 (100mS pulse)
- SB23, Enable all HMI keys during Keypad Entry
- SB26, Exiting OS Draw Mode (ON for 1 cycle after OS draw)
- SB27, Enter Display without active Keypad Entry
- Variables
- SB29, Current keypad entry sets SB 30 (HMI keypad entries complete)
- SB36, INFO mode
- SB37, Exclude Last Viewed Display from FIFO
- SB38, Invert Touch screen element pixels (Text, images)
- SB54, Key <i>
- SB102, MODBUS Read Long: Transpose 16 bits of 32-bit long
- SB279, Send SMS message in ASCII format (ON sends ASCII)
- SB280, Force Message Display on Cell Phone
- SB300, Reset PLC
- SB501, Retain Inputs Forced Value after power failure

SIs
- SI40, Touch screen is being touched - X coordinates
- SI41, Touch screen is being touched - Y coordinates
- SI50, INFO delay time (default 4 seconds)
Updating Project Versions

Opening a project created in a previous version of VisiLogic enables you to update the project. Please note the following:

- If you open the project with the new version, but do not save it before closing it, no changes are made to your project.

- VisiLogic automatically creates a backup file of the project you are updating. This file is located in the project directory. This backup file does not have the .vlp (VisiLogic) file extension. In order to open the backup, you must change the file extension to .vlp. You can also save the original file by opening the project, and then performing File>Save As, assigning the new file a different name.

- In order to deliver a high level of service, Unitronics issues software service releases that fix known issues. However, in some cases, users develop workarounds for these issues. If you have developed a workaround in your project, and then update to a VisiLogic/OS version that fixes the original issue, your workaround may not function as you expect.

- Known Issues: Version Incompatibility
  Certain versions have changes that may impact on the running of an existing application if you update the OS in the PLC.

  **V120-12-xxx** is no longer supported, in released version VisiLogic 4.7.4, OS 470 (06), and later.

<table>
<thead>
<tr>
<th>Previous to Version</th>
<th>After Version</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Version 4.00, Build 00</strong></td>
<td></td>
</tr>
<tr>
<td>Call Display function</td>
<td></td>
</tr>
<tr>
<td>Any contact could be used to trigger a Call Display function to call and load a display.</td>
<td>A positive transition contact , or the rising edge of a contact such as SB 7 100mS Pulse is required to trigger a Call Display function.</td>
</tr>
<tr>
<td>PID function</td>
<td></td>
</tr>
<tr>
<td>VisiLogic versions older than 4.00 contained a PID function. This function has been replaced by the PID FB, which offers Auto-tune plus other advanced operations. If you open a project which implemented PID using the older PID, you will receive the following error message: &quot;This project contains X number of outdated PID loops. Using outdated PID limits you to 4 PID loops. For more information, please click on the Help button below.&quot; Although older projects will function, it is recommended that you update these projects, replacing the PID function with the PID FB. Please note that</td>
<td></td>
</tr>
</tbody>
</table>
**Appendix A: Troubleshooting Updating Project Versions**

**V120-12** continues to support the older PID function, continues to support up to 18 PID loops, but **does not support the PID FB**.

<table>
<thead>
<tr>
<th><strong>Set PLC Name function</strong></th>
<th><strong>Set PLC Name was not required in TCP/IP applications.</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Version 4.00, Build 10</strong></td>
<td><strong>Set PLC Name is required in TCP/IP applications.</strong></td>
</tr>
</tbody>
</table>
| **Read \ Write Column Data Tables function** | **The function was not FIFO-based.**  
For example, assume the Data Table has 10 rows. If the Read Column function is pointing at Row Number 3, and the Number of Rows to be read is 10, the function would read only 7 rows of data.  
| **Version 4.00, Build 15** | **The function is now FIFO-based. If the Data Table has 10 rows, and the Read Column function is pointing at Row Number 3, and the Number of Rows to be read is 10, the function will read the last 7 rows of data, and also automatically read the top three rows, for a total of 10 rows of data.** |
| **Display String function** | **Only the rising edge of the refresh bit can trigger Display String.** |
| **Version 4.00, Build 22** | **MODBUS slave addressing**  
As of this version, the Slave addressing scheme for Timer / Counter, Current and Preset, was changed.  
| **Version 4.00, Build 23** | **SB 250 Keypad entry within limits, SB 251 Keypad entry exceeds limits**  
These SBs would turn ON, and remain ON. They would turn OFF only after the display was fully loaded.  
| **Touch-screen PLCs: Touch elements** | **These SBs now turn OFF either when:**  
- The current Display is either recalled or changed, or  
- At the beginning of the next program cycle.  
| **Version 4.50** | **Bits related to touch-screen elements were not reset at power-up.**  
**Bits related to touch-screen elements are now reset at power-up.**  
| **When:**  
- a project containing graphics was originally written using a VisiLogic version lower than 4.00,  
- and then saved using a version between V4.0X -V4.50,  
- and then reopened in VisiLogic 4.50 or higher,  
certain images may not display correctly. Such images may have to be reinserted in order to ensure
correct display.

**Version 4.50, Build 02**

Touch-screen PLCs: Display buzzer

The buzzer would sound whenever any part of the screen was touched.  
The buzzer now sounds only when touch-screen elements are touched.

**Version 4.50, Build 06**

Display jumps, SB 250

(V290 only) SB 250 could not be used to trigger Display jumps.  
(V290 only) SB 250 can now trigger Display jumps.

FB Communication Protocol

When messages were received, and data errors were discovered, the datacheck process stopped prematurely.  
Now all messages are checked, regardless of whether any contain data errors.

<table>
<thead>
<tr>
<th>Previous to Version</th>
<th>After Version</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Version 4.7.4, Build 06</strong></td>
<td>As of this version V120-12-xxx is not supported, and does not appear in Hardware Configuration.</td>
</tr>
</tbody>
</table>

If you want to edit an older application based on a V120-12-xxx, you can use the 'VisiLogic Version Swapper', which is part of the VisiLogic installation. The Swapper is located in the Unitronics directory, typically located at:  
Start>Programs>Unitronics>VisiLogic>VisiLogic Version Swapper.

**Previous to Version 7.00**

CANopen compatibility break

The CANopen System Operand addressing scheme changed as of VisiLogic version 7.00, OS 2.00 (Standard Division) OS 5.02 (Enhanced Division).

You can choose to continue editing older applications using previous VisiLogic versions contained in the VisiLogic Version Swapper. Note that in this case the controller **must** use an older OS.

However, if you choose to update the application and OS, note that you must change the system operands according to the following table.

<table>
<thead>
<tr>
<th>System Integers</th>
<th>System Double Words</th>
</tr>
</thead>
<tbody>
<tr>
<td>Old</td>
<td>New</td>
</tr>
<tr>
<td>200</td>
<td>211</td>
</tr>
<tr>
<td>201</td>
<td>212</td>
</tr>
<tr>
<td>202</td>
<td>213</td>
</tr>
<tr>
<td>203</td>
<td>214</td>
</tr>
<tr>
<td>204</td>
<td>215</td>
</tr>
<tr>
<td>205</td>
<td>216</td>
</tr>
<tr>
<td>206</td>
<td>217</td>
</tr>
<tr>
<td>207</td>
<td>218</td>
</tr>
<tr>
<td>208</td>
<td>219</td>
</tr>
<tr>
<td>240</td>
<td>220</td>
</tr>
<tr>
<td>241</td>
<td>221</td>
</tr>
<tr>
<td>242</td>
<td>222</td>
</tr>
</tbody>
</table>
Appendix A: Troubleshooting

Why does the Controller display the 'Restart' message?

The most common reason for this event is a peak in electromagnetic (EMF) 'noise'. This may result from contactors, power relays, solenoid valves, etc. switching on and off, as well as from power transformers and motor speed drivers.

Recommendations

- Use different power supplies - highly recommended - one for the controller (CPU and inputs), and a different one for other electromagnetic devices;
- Use suppressors - reverse connected diodes for DC loads and RC filters for AC loads;
- Where possible, place the signal cables, including the 24V power supply, far away from power lines, especially from cables, coming in and out of motor drivers;
- If needed, use shielded cables for signals, including for 24 VDC and for power cables between the motor driver and the motor itself.

Taking these precautions should help prevent 'Controller Restart'. If the problem persists, contact support@unitronics or your local Unitronics representative.

HMI Element Resizing/Rotating Limitations

Elements 'grow' down, and to the right.

- If resizing/rotating will cause Variable elements to collide, or any element to extend beyond the boundaries of the Display, the element cannot be returned to its original size, or resized to a larger size.
- When you open an element for editing, and then press OK, VisiLogic resizes the element. If the new size of the element causes Variable elements to collide, or any element to extend beyond the boundaries of the Display, VisiLogic displays an error message: 'Operation Cannot Be Completed'.

Note

'Original size' is the actual size of the element as it appears in the element's ToolTip.
- Fit to Original Size does not affect geometric shapes that are drawn on the Display.
- 'Original size' cannot be used to resize Variable elements if the elements have different original sizes.
Notes

- Although an imported image can be resized, resizing may result in some degree of distortion. To avoid this, use images that are created to match the required size.
- Resizing text elements changes the size of the text field, but does not affect font size.
- Shapes that are imported are resized in proportion to their original size.

Blank Corner in HMI Display
While you download an application, a flashing square or box is present in the upper left-hand corner of the PLC display screen. When the PLC returns to Run mode, you may note that a small square in the upper left-hand corner of the screen is blank.

This is part of the normal download process. The screen will recover as soon as the display is refreshed for any reason.

Float Errors
When an Float function error occurs, SB 10 Float Error turns on. This SB is reset by the user.

The error code is stored in SI 440 General Error. The codes are shown below.

<table>
<thead>
<tr>
<th>Value</th>
<th>Message</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Integer Overflow</td>
<td>7FFF or 8000 (integer result) FFFF or 0000(unsigned integer result)</td>
</tr>
<tr>
<td>4</td>
<td>Floating Overflow</td>
<td>+INF or -INF (float result)</td>
</tr>
<tr>
<td>5</td>
<td>Floating Underflow</td>
<td>0.0 (float result)</td>
</tr>
<tr>
<td>7</td>
<td>Divide by Zero</td>
<td>+INF or -INF or NaN (float result)</td>
</tr>
<tr>
<td>9</td>
<td>Undefined Float</td>
<td>NAN (float result)</td>
</tr>
<tr>
<td>10</td>
<td>Conversion Error</td>
<td>0 (integer result)</td>
</tr>
<tr>
<td>11</td>
<td>Floating point Stack Overflow</td>
<td>Floating point stack underflow</td>
</tr>
<tr>
<td>12</td>
<td>Floating point Stack Underflow</td>
<td>Floating point stack overflow</td>
</tr>
</tbody>
</table>

INF Infinite which is the largest absolute floating point number.
NAN Not a Number, special notation for undefined floating point number.

Changing Panel Types: Conflicts
If a project contains Displays, selecting a different panel type in your project's Hardware Configuration may cause you to lose some of your Display elements and their properties.
If you select a smaller panel, some of the elements in your Displays may be too large. In this case, any variable, graphic, or text elements that extend beyond the edge of the screen will be deleted from your project, and may not be retrieved.

In addition, note that all calendar variables will be deleted.

Also, note that if you change from a touch panel to a non-touch panel, any 'touch' properties linked to on-screen objects will be deleted.

**Insufficient Flash Memory**

This error message is displayed when the PLC does not have sufficient memory to handle the current project. To see the memory requirements of the project, click the Events tab in the Output Window at the bottom of the screen.

<table>
<thead>
<tr>
<th>Source</th>
<th>Date and Time</th>
<th>Event Description</th>
<th>Memory Allocation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory Allocation</td>
<td>3/5/2013 11:14:04 AM</td>
<td>Upload data</td>
<td>32</td>
</tr>
<tr>
<td>Memory Allocation</td>
<td>3/5/2013 11:14:04 AM</td>
<td>Function block</td>
<td>34</td>
</tr>
<tr>
<td>Memory Allocation</td>
<td>3/5/2013 11:14:04 AM</td>
<td>Ladder Tkers</td>
<td>94</td>
</tr>
<tr>
<td>Memory Allocation</td>
<td>3/5/2013 11:14:04 AM</td>
<td>Static pages</td>
<td>66</td>
</tr>
<tr>
<td>Memory Allocation</td>
<td>3/5/2013 11:14:04 AM</td>
<td>User fonts</td>
<td>136266</td>
</tr>
<tr>
<td>Memory Allocation</td>
<td>3/5/2013 11:14:04 AM</td>
<td>Variables</td>
<td>32</td>
</tr>
</tbody>
</table>

**Error: User Memory Overlap**

This error generally results because the number of function blocks exceeds the PLC memory capacity. Please review your program, and consider making changes regarding FB operations. In most cases, this can be resolved by deleting a single function block.

**Replacing or Removing the Battery**

After replacing the PLC battery, initialize the PLC via Info Mode Info>System>Working Mode> Init.

**Note**  
When you replace the battery, you lose RAM values.

**Backing up the PLC RAM**

Unitronics Remote Access PC utility offers the tool 'Backup PLC RAM'. Using this tool, you can read all PLC RAM values such as Data Tables and register values into an Excel file on your PC, and later write these Excel values back into the PLC’s RAM.

Remote Access may be installed from the Setup CD, or downloaded from http://www.unitronics.com/download.htm
Appendix B: Vision Controller Divisions

There are two major Vision divisions, Standard and Enhanced.

<table>
<thead>
<tr>
<th>HMI - Physical differences</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Division</strong></td>
</tr>
<tr>
<td>Standard Vision</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Enhanced Vision</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

Communications

MODBUS is **fully supported** by both divisions. However, **slave addressing schemes differ**. Refer to the MODBUS Help topic Slave Addressing.

Modems

- **Standard Vision Division**
  Controllers in this division can only support a single modem. You can connect a modem to any COM port. However, note that SB 184 TX Success and SB 185 TX Failed indicate message transmission status regardless of the actual COM port connected to the modem.

- **Enhanced Vision Division**
  Controllers in this division can support a modem on each COM port. Each port is linked to a Succeed and Fail SB: COM1: SB 184 and SB 185, COM2: SB 186 and SB 187, COM3: SB 188 and SB 189.

General Features

<table>
<thead>
<tr>
<th><strong>Division</strong></th>
<th><strong>Download/Upload</strong></th>
<th><strong>Alarms, String Library</strong></th>
<th><strong>Operands</strong></th>
</tr>
</thead>
</table>
| Standard Vision | A downloaded project:  
|               | • is burned to PLC FLASH 
|               | • contains a Upload file | Not supported | Fast Operands: Not supported |
| Enhanced Vision | Select Download options to:  
|               | • burn project to PLC FLASH 
|               | • burn an Upload file | Fully supported | More operands. Fast Operands: Fully supported |
Replacing or Removing the Battery

Appendix B: Vision Controller Divisions

<table>
<thead>
<tr>
<th>Division</th>
<th>Displays</th>
<th>HMI Objects</th>
<th>Call Subroutine from Display</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Standard Vision</strong></td>
<td>255</td>
<td>Does not support Trends HMI object</td>
<td>You can link 1 subroutine to a Display.</td>
</tr>
<tr>
<td><strong>Enhanced Vision</strong></td>
<td>1024</td>
<td>Does not support:</td>
<td>Moving Images, Global Variables</td>
</tr>
</tbody>
</table>

**Color Vision**

Color Vision controllers belong to the Enhanced Division, and offer some additional HMI object properties.

<table>
<thead>
<tr>
<th>Division</th>
<th>Additional HMI Shapes</th>
<th>Trends</th>
<th>Graphs</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Standard Vision</strong></td>
<td></td>
<td>Trend and Axis FBs</td>
<td></td>
</tr>
<tr>
<td><strong>Color Enhanced Vision</strong></td>
<td>Frame and Button</td>
<td>Trends HMI Object</td>
<td>LEDs, Thermometer</td>
</tr>
</tbody>
</table>

**Note**

Font Handler: Color Vision models, such as V570, use default system fonts. These fonts (which are highlighted in grey) contain a limited character set, and cannot be modified. To add a font that contains additional / multilingual characters, click on the Add New Font button..

**Ladder Functions**

<table>
<thead>
<tr>
<th>Functions</th>
<th>Standard</th>
<th>Enhanced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Subroutine</td>
<td>A single net can include 2</td>
<td>A single net can include only 1</td>
</tr>
<tr>
<td></td>
<td>Call Subroutine functions</td>
<td>Call Subroutine function</td>
</tr>
<tr>
<td>Load HMI Display</td>
<td>A single net can include 2</td>
<td>A single net can include only 1</td>
</tr>
<tr>
<td></td>
<td>Load HMI Display functions</td>
<td>Load HMI Display function</td>
</tr>
</tbody>
</table>

**Special Issues**

**Virtual Keypads: Enhanced Touchscreen Models**

When you create a variable that requires the operator to enter data, you can select one of the three keypad types shown in the following table type. The type is reflected in SI 49.

<table>
<thead>
<tr>
<th>Value: SI</th>
<th>0</th>
<th>1</th>
<th>257</th>
</tr>
</thead>
</table>
Appendix B: Vision Controller Divisions

VisiLogic: Getting Started 121

Project Conversion
Projects may be converted from the:
- V120 to the V130
- From monochrome to color Project>Convert Project to Color.

Keypad Entry
The following table shows differences between keypad entry variables.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Standard</th>
<th>Enhanced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keypad Entry Variables</td>
<td>SB 250 HMI key entry within limits (Standard Vision only)</td>
<td>SB 92 Keypad Entry in Progress (ON during entry) (Enhanced Vision)</td>
</tr>
<tr>
<td></td>
<td>SB 251 Keypad entry exceeds limits (Standard Vision only)</td>
<td>SB 93 Keypad Entry Var Activates (ON for 1 scan) (Enhanced Vision)</td>
</tr>
<tr>
<td></td>
<td>SI 249 Last Active Keypad Entry Var (Standard Vision only)</td>
<td>SB 94 Keypad Entry Var Complete (ON for 1 scan) (Enhanced Vision)</td>
</tr>
<tr>
<td></td>
<td>SI 250 Currently active keypad entry (read/write) (Standard Vision only)</td>
<td>SI 45 Numeric Key Entry Out of Limit - Counter of Attempts (Enhanced Vision) (Counts the number of failed attempts to enter a value)</td>
</tr>
<tr>
<td></td>
<td>SDW 10 Keypad entry variable value</td>
<td>If a Legal Entry bit is defined, SB 94 does not turn ON if the entered value is out of range. The keypad stays on screen until a legal value is entered. You can use SI 45 in conjunction with a Compare function to exit the variable.</td>
</tr>
</tbody>
</table>

| Active Keypad Entry (SBs)        | SB 32 HMI Keypad Entry in Progress (Standard Vision) rises during keypad entry | SB 92 HMI Keypad Entry in Progress (Enhanced Vision) rises during keypad entry |
|                                  |                                                                         | If SB 76 is OFF after Keypad Entry, the user must use the arrow keys to move to the next variable. Turning SB 76 on causes the next variable set in Variable Tab Order to automatically become active. |

Keypad Entry: Focus
After Keypad Entry, the next variable set in Variable Tab Order automatically becomes active.
<table>
<thead>
<tr>
<th><strong>Password Entry via HMI</strong></th>
<th><strong>Entering a legal keypad entry value</strong></th>
<th><strong>Entering an illegal keypad entry value</strong></th>
<th><strong>Active Keypad Entry Variables (SIs)</strong></th>
<th><strong>Keypad Vars Locked</strong></th>
<th><strong>Enter ASCII value</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>- Correct password turns SB250 ON</td>
<td>SB 250 Keypad entry Within Limits turns ON for 1 scan</td>
<td>SB 251 Keypad Entry Exceeds Limits turns ON for 1 scan</td>
<td>SI 250 Last Active Keypad Variable contains the number of that variable SI 251 Currently Active Keypad Entry contains the number of that variable. The application can change the operand value to force a variable into active state</td>
<td>By OS, after all HMI keypad entries are complete By SB29 turning ON</td>
<td>Currently Active Keypad Entry</td>
</tr>
<tr>
<td>- Wrong Password turns SB251 ON</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Legal Entry bit in Password Variable turns ON only when correct password is entered.</strong></td>
<td><strong>SB 94 Keypad Entry Var Complete + Keypad entry property:</strong> Legal Entry MB</td>
<td><strong>Turns ON when entered value is within legal limits</strong></td>
<td><strong>Enhanced Vision (V130 only)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>The keypad stays on screen until a legal password is entered.</strong></td>
<td><strong>Does not turn ON when entered value exceeds legal limits</strong></td>
<td></td>
<td><strong>Turn ON by use</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>To limit the number of wrong entries, you can use SI 45 in conjunction with a Compare function to exit the variable.</strong></td>
<td></td>
<td></td>
<td><strong>Turn ON to lock all keypad entry variables.</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Appendix B: Vision Controller Divisions

The V120 and V130

Both the V120 and V130 are highly compact controllers with built-in on-board I/O configurations, and may be used in similar applications. However, applications written for the V120 may not be 'plug-and-play' for the other, and may have to be adapted. This is because these controllers belong to different Vision Controller Divisions; V120 is a Standard Vision, whereas V130 is a member of the Enhanced Vision division.

Certain system operands that are relevant for the V120 may not function or may function differently. These differences are explained in the following sections.

In addition, please note that the method of data entry (using the keypad to enter data into Keypad Entry Variables) is different.

Converting an existing V120 application to V130

To convert V120 projects to V130, use Project>Convert Project to V130.

Key issues

MODBUS is fully supported; however, to adapt V120 applications you must change the slave addressing scheme as described in the MODBUS Help topic Slave Addressing.

Keypad function

<table>
<thead>
<tr>
<th>Feature</th>
<th>V120</th>
<th>V130</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up/Down keys</td>
<td>Up arrow: linked to SB 41, down arrow to SB 46</td>
<td>Up arrow: linked to SB 55, down arrow to SB 56</td>
</tr>
<tr>
<td>Keypad entry 'logic'</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Entry to Display with keypad entry variables</td>
<td>The first variable set in Variable Tab order is active and blinking.</td>
<td>No variable is active; press Enter to activate the first variable set in Variable Tab order.</td>
</tr>
</tbody>
</table>
| Time Variables, Day of Week/Month| • Pressing Enter selects the highlighted day; at the end of a row, pressing Enter selects the final day and causes the cursor to jump to the next row.  
• Navigate between the days via the Up/Down arrows. | Pressing Enter selects the highlighted day; at the end of a row, pressing Enter jumps to the start of the same row. Navigate between the rows via the Up/Down buttons.  
When Entry is complete, press ESC key, then move to the next variable via the right arrow key. |
<p>| Moving between variables         | Press Enter after enter a value; use the right arrow key to move to the next variable. | After pressing the ESC key to signal Entry complete, use the right/leftarrow keys to move between variables. |
| ASCII keypad entry: upper/lower case | During entry, pressing the &lt;i&gt; button changes toggles the case. | Press the up arrow for upper case; the down arrow for lower case. |
| F1 and F2 keys                   | Do not exist                              | F1 is linked to SB 58, F2 to SB 59.      |</p>
<table>
<thead>
<tr>
<th>Ladder Feature</th>
<th>V120</th>
<th>V130</th>
</tr>
</thead>
<tbody>
<tr>
<td>Call Subroutine</td>
<td>A single net can include 2 Call Subroutine functions</td>
<td>A single net can include <strong>only 1</strong> Call Subroutine function</td>
</tr>
<tr>
<td>Load HMI Display</td>
<td>A single net can include 2 Load HMI Display functions</td>
<td>A single net can include <strong>only 1</strong> Load HMI Display function</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>HMI Feature</th>
<th>V120</th>
<th>V130</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load Subroutine</td>
<td>SB 33 Load Display with linked Call Subroutine turns ON for 1 scan</td>
<td>Each Display is linked to 3 subroutines:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The first runs when the Display begins to load</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The second runs while the Display is shown</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• The third runs when the Display begins to unload</td>
</tr>
<tr>
<td>Unload Subroutine</td>
<td>SB 34 UnLoad Display with linked Call Subroutine turns ON for 1 scan</td>
<td></td>
</tr>
<tr>
<td>What is current Display?</td>
<td>According to SI 252 Current HMI Display Number</td>
<td>Use Ladder function HMI&gt;HMI Display Loaded (SI 252 not relevant)</td>
</tr>
<tr>
<td>What was Previous HMI Display?</td>
<td>According to SI 251 Previous HMI Display Number</td>
<td>Use Ladder function HMI&gt;Is Last HMI Display Loaded (SI 252 not relevant)</td>
</tr>
<tr>
<td>Moving Images</td>
<td>Supported</td>
<td>Not supported. Are removed when the project is converted</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Variables</th>
<th>V120</th>
<th>V130</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day of Week/Month</td>
<td>These variables occupy less screen area in V120.</td>
<td>When converting an application from V120 to V130, you must manually resize these variables</td>
</tr>
<tr>
<td>Hide/Invert Variable</td>
<td>Use the Ladder elements Invert/Hide Var</td>
<td>Use the Hide or Inverse=view bit in the Variable's properties</td>
</tr>
<tr>
<td>Global Variables</td>
<td>Supported</td>
<td>Not supported; each Global Variable is replaced with a separate variable when the project is converted</td>
</tr>
<tr>
<td>Keypad Entry Variables</td>
<td>SB 92 Keypad Entry in Progress (ON during entry) (Enhanced Vision)..</td>
<td>SB 92 Keypad Entry in Progress (ON during entry) (Enhanced Vision)</td>
</tr>
<tr>
<td></td>
<td>SB 93 Keypad Entry Var Activates (ON for 1 scan) (Enhanced Vision)..</td>
<td>SB 93 Keypad Entry Var Activates (ON for 1 scan) (Enhanced Vision)</td>
</tr>
<tr>
<td></td>
<td>SB 94 Keypad Entry Var Complete (ON for 1 scan) (Enhanced Vision)..</td>
<td>SB 94 Keypad Entry Var Complete (ON for 1 scan) (Enhanced Vision)</td>
</tr>
<tr>
<td></td>
<td>SB 250 HMI key entry within limits (Standard Vision only)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SB 251 Keypad entry exceeds limits (Standard Vision only)</td>
<td></td>
</tr>
</tbody>
</table>
### Appendix B: Vision Controller Divisions

<table>
<thead>
<tr>
<th><strong>Replacing or Removing the Battery</strong></th>
<th></th>
</tr>
</thead>
</table>

| Vision only)  |
| SI 249 Last Active Keypad Entry Var (V120, V230, V260, V280, V290 BW only)  |
| SI 250 Currently active keypad entry (read/write) (Standard Vision only)  |
| SDW 10 Keypad entry variable value  |

<table>
<thead>
<tr>
<th><strong>Active Keypad Entry (SBs)</strong></th>
<th>SB 32 HMI Keypad Entry in Progress (Standard Vision) rises during keypad entry</th>
<th>SB 92 HMI Keypad Entry in Progress (Enhanced Vision) rises during keypad entry</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>Keypad Entry:</strong> Focus</th>
<th>After Keypad Entry, the next variable set in Variable Tab Order automatically becomes active.</th>
<th>If SB 76 is OFF after Keypad Entry, the user must use the arrow keys to move to the next variable. Turning SB 76 on causes the next variable set in Variable Tab Order to automatically become active.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>Password Entry via HMI</strong></th>
<th></th>
</tr>
</thead>
</table>

*bullet* Correct password turns SB250 ON  
*bullet* Wrong Password turns SB251 ON  
Legal Entry bit in Password Variable turns ON when correct password is entered.

<table>
<thead>
<tr>
<th><strong>Entering a legal keypad entry value</strong></th>
<th>SB 250 Keypad entry Within Limits turns ON for 1 scan</th>
<th>SB 94 Keypad Entry Var Complete + Keypad entry property: Legal Entry MB</th>
</tr>
</thead>
</table>

*bullet* Turns ON when entered value is within legal limits  
*bullet* Turns OFF when entered value exceeds legal limits  

<table>
<thead>
<tr>
<th><strong>Entering an illegal keypad entry value</strong></th>
<th>SB 251 Keypad Entry Exceeds Limits turns ON for 1 scan</th>
<th></th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>Active Keypad Entry Variables (SIs)</strong></th>
<th>SI 250 Last Active Keypad Variable contains the number of that variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>SI 251 Currently Active Keypad Entry contains the number of that variable. The application can change the operand value to force a variable into active state</td>
<td>SI 250 Last Active Keypad Variable and SI 251 Currently Active Keypad Entry contains the number of the relevant DLU.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Keypad Vars Locked</strong></th>
<th>Enhanced Vision (V130 only) Turned ON by user</th>
<th>Turn ON to lock all keypad entry variables.</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>Enter Display with locked Keypad Entry Variables</strong></th>
<th>In Ladder application, set SB30</th>
<th>Same</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th><strong>Enter ASCII value</strong></th>
<th>Currently Active Keypad Entry</th>
<th></th>
</tr>
</thead>
</table>
Index
Replacing or Removing the Battery

A
Analog I/Os 15, 49, 51, 53, 113
   Analog Input 49, 53
   Analog Output 51, 53
Configuring I/O Expansion Modules 38, 49, 53, 107
Configuring Snap-in I/O Modules 42, 49, 53, 107
Hardware Configuration 15, 53
PT100 Input 40

B
backup 122
Battery 122
Baud 59
Download 61
Get COM parameters 60
boot 102
Bootstrap 102

C
CANbus 33, 39, 63
color blind 79
Comment 85
communication cable 23
Communications 33, 34, 59, 60, 102
   Log 102
   Modem 34, 60
Compatibility 115
Compile 101, 114
Contacts 109
Controller 17, 59, 60
Counter 40, 42, 45
Counter Values 45
Counter w/reset 15, 38, 40, 42, 45

D
Data, entry via keypad 19
Debug 27, 107
Delete 38
Descriptions 57
Digital I/Os 15, 38, 42
Digital Outputs 38, 42, 46, 56
digital signatures 83
Direct Connection 59
Display text messages 19
Displaying Values 19
Displays 17, 18, 19, 121
Downloading 23, 61, 77
OS 61
Project 23
Duty Cycle 46
dvi 77
DW 49

E
editing, keyboard 85
EMF 9
EMI 9
Enter data via keypad 19
password 19
Errors 113, 122
Filter 49
Find 89
Find & Replace 89
Constant 89
Element 89
FB 89
Font 89
Label 89
Load Display 89
Operand 89
Operand 89

VisiLogic: Getting Started
Replacing or Removing the Battery

Subroutine ................................. 89
Float functions ........................ 121
Folders ..................................... 87
Force I/O .................................. 27, 107
Force Input ................................ 27, 107
Force Output ................................ 27, 107
Frequency Measurer ................. 15, 46
Function .................................. 15, 121

G
Graphics ..................................... 96
Graphs ...................................... 19

H
Hardware Configuration............. 15, 38, 42, 45, 46
High Speed Input ............. 15, 38, 42
High Speed Output (HSO) .... 15, 44, 46
High-Speed Counter ........... 15, 40, 42, 45
HMI ........................................ 17, 18
hotkeys .............................. 85

I
I/Os .......... 15, 37, 38, 39, 40, 42, 44, 48, 84
I/O Expansion Modules 15, 37, 38, 40, 42, 45, 51, 113
I/O Snap-in Modules ................. 42, 44
Image ................................... 17, 19, 96
Import/Export ......................... 97
Information Mode .... 18, 29, 113
Input ..................................... 38, 42

K
keyboard .................................. 85
Keypad .................................... 18
Keypad Entry ..................... 18, 19

L
Labels ...................................... 85
Ladder .................................... 15, 22, 27, 107
Log ......................................... 102

M
Memory ................................... 105
MI 22 Duty Cycle Value .............. 46
MI-Memory Integers .............. 49
MJ10-22-CS25 ......................... 23
ML-Memory Long Integers ....... 49
Modem ................................. 34
Modules .................................. 15
N
Navigation ................................ 22
Nets ...................................... 15, 87
Network .................................. 59, 63
npn .................................... 15, 38, 42

O
Operand ................................ 49, 84, 87, 89, 94
Operand Description .......... 57, 94
Operating System .................. 61
Optimization ......................... 101
OS ....................................... 61, 102
Outputs .......................... 38, 56, 107

P
Password .............................. 29, 79
PC ........................................ 59
PC COM Parameters .............. 59
PLC ......................................... 60
PLC status .......................... 60
pnp .................................. 15, 38, 42
PNP/NPN ......................... 55, 56
Port ..................................... 33, 59
Positive Transition Contact .... 109
Power ..................................... 102
Power-up modes ................. 102
Programming cable ............ 23
Project .............................. 22, 23, 27, 107
Project Conversion .......... 97
PT100 ................................ 40
PT4 ...................................... 40
Index

Pulse .............................................40, 46
PWM-Pulse Width Modulation 15, 42, 46

R
Rails .............................................15
Range enter ..................................46
Relay ............................................56
Reload ..........................................42
Remote Access ..........................34, 77
Remote I/Os ..................................37, 39
Remote PLC Programming ...............65
Remove I/Os ..................................38
Rename
  Watch Folder ................................ 87
Reset ...........................................60, 113
Run .............................................60
Rung ............................................15

S
Scan ..............................................27, 107
Search ..........................................89
  Symbolic Name ..............................94
security .........................................83
Shaft Encoder ..........................15, 42, 45
Shortcut keys ..................................85
Single scan .................................27, 107
Snap-in I/O Module ...............15, 42, 45
Stepper ..........................................44
Stop Mode ....................................113
Subroutines .................................15, 97
Symbols .........................................57

T
Test mode ......................................27, 84, 107
Total cycle period ..........................46
Touch-screen ..................................18, 29
Transistor .....................................56
Triggering signal ..........................109
Troubleshooting ........................9, 23, 27, 102, 107, 113, 115, 121, 122

U
Unidownloader ..................................77
Upload ..........................................23
utility ...........................................96, 101

V
V120-12 .........................................115
V290 .............................................29
Variables .......................................17, 19
View Window ...............................84, 87, 88, 102
Vision OPLC Information 15, 59, 61, 63

W
Watch Folder .....................................87
Replacing or Removing the Battery